
Contents

51 OneClick for Admins — Installing the Diligent Boards client

132 OneClick for Admins — Introducing the client

183 OneClick for Admins — The admin home page

214 OneClick for Admins — Enabling and editing alerts

245 OneClick for Admins — Creating a new book

306 OneClick for Admins — Adding conferencing information to a book

357 OneClick for Admins — Copying an existing book

388 OneClick for Admins — Changing the order of books

409 OneClick for Admins — Moving a book to a different meeting group

4310 OneClick for Admins — Selecting a book from the home page

4611 OneClick for Admins — Selecting a book from the admin home page

4912 OneClick for Admins — Gathering board documents

5113 OneClick for Admins — Importing a new book from a folder

5514 OneClick for Admins — Importing a new book from a bookmarked PDF

5715 OneClick for Admins — Importing a report from Diligent Entities

6216 OneClick for Admins — Using the edit book window

6517 OneClick for Admins — Editing the book title and date

6718 OneClick for Admins — Adding a blank or copied tab

7019 OneClick for Admins — Importing tabs from a folder

7420 OneClick for Admins — Importing tabs from a bookmarked PDF

7921 OneClick for Admins — Editing and deleting a tab

8222 OneClick for Admins — Re-ordering tabs

8423 OneClick for Admins — The Agenda – Adding an agenda tab

© 2021 Diligent Corporation. All rights reserved.

www.princexml.com
Prince - Non-commercial License
This document was created with Prince, a great way of getting web content onto paper.



8724 OneClick for Admins — The Agenda – Adding the agenda document

9025 OneClick for Admins — Agenda Builder — Quickstart

9426 OneClick for Admins — Agenda Builder — Initial settings

9927 OneClick for Admins — Agenda Builder — Adding agenda items

10228 OneClick for Admins — Agenda Builder — The Agenda Builder screen

10429 OneClick for Admins — Agenda Builder — Generating and updating the agenda

10730 OneClick for Admins — Agenda Builder — The agenda document

11131 OneClick for Admins — Publishing, hiding and archiving books

11332 OneClick for Admins — Sending notifications about new books

12033 OneClick for Admins — Deleting a book

12334 OneClick for Admins — Uploading additional documents

12835 OneClick for Admins — Previewing an uploaded document

13136 OneClick for Admins — Updating or replacing a document

13437 OneClick for Admins — Update History

13638 OneClick for Admins — Rearranging documents

13839 OneClick for Admins — Hiding or deleting documents

14240 OneClick for Admins — EasyEdit — Getting started and the Home tab

15541 OneClick for Admins — EasyEdit — The Insert tab

15942 OneClick for Admins — EasyEdit — Inserted tables — Design

16343 OneClick for Admins — EasyEdit — Inserted tables – Layout

16644 OneClick for Admins — EasyEdit — The Page Layout tab

16945 OneClick for Admins — EasyEdit — The View tab

17146 OneClick for Admins — EasyEdit — Importing, exporting and the File tab

17347 OneClick for Admins — Selecting a book for approval from the home page

|
2 of 312 | Diligent Corporation



17548 OneClick for Admins — Selecting a book for approval from the admin home page

17849 OneClick for Admins — The Approve Book window

18050 OneClick for Admins — Approving the book

18451 OneClick for Admins — Checking document status

18752 OneClick for Admins — Creating QuickLinks in uploaded documents

19053 OneClick for Admins — Creating QuickLinks in EasyEdit documents

19354 OneClick for Admins — Editing and deleting QuickLinks in uploaded documents

19455 OneClick for Admins — Editing and deleting QuickLinks in EasyEdit documents

19656 OneClick for Admins — Creating external QuickLinks

19957 OneClick for Admins — Printing a book

20458 OneClick for Admins — Watermarking documents

20759 OneClick for Admins — Creating a voting document

21560 OneClick for Admins — Checking vote status

21861 OneClick for Admins — Questionnaires — Adding a new questionnaire

22162 OneClick for Admins — Questionnaires — Adding an Introduction page to a questionnaire

22463 OneClick for Admins — Questionnaires — Adding and managing questionnaire pages

22764 OneClick for Admins — Questionnaires — Adding and managing questions

23065 OneClick for Admins — Questionnaires — Text, Date, and Email question types

23266 OneClick for Admins — Questionnaires — The Number question type

23567 OneClick for Admins — Questionnaires — The List question type

23968 OneClick for Admins — Questionnaires — Contingent questions

24169 OneClick for Admins — Questionnaires — Finalizing the questionnaire

24470 OneClick for Admins — Questionnaires — Managing and publishing questionnaires

24871 OneClick for Admins — Questionnaires — Additional questionnaire features

|
3 of 312 | Diligent Corporation



25072 OneClick for Admins — Questionnaires — Gathering questionnaire responses

25273 OneClick for Admins — Questionnaires — Printing questionnaires

25874 OneClick for Admins — Questionnaires — Exporting questionnaires to PDF

26475 OneClick for Admins — Editing the Resource Center

26776 OneClick for Admins — Adding a Resource Center folder

27177 OneClick for Admins — Editing, deleting and publishing a Resource Center folder

27478 OneClick for Admins — Resource Center categories

27979 OneClick for Admins — Re-ordering Resource Center folders and documents

28180 OneClick for Admins — Uploading and approving Resource Center documents

28381 OneClick for Admins — User management

28582 OneClick for Admins — Approving new users

28883 OneClick for Admins — Managing user roles

29184 OneClick for Admins — Exporting a list of users

29385 OneClick for Admins — Granting temporary site access

29686 OneClick for Admins — Timeout management

29987 OneClick for Admins — Editing contact information

30388 OneClick for Admins — Editing board member signatures

30589 OneClick for Admins — Editing board member passwords and security questions

30990 OneClick for Admins — Editing the calendar

|
4 of 312 | Diligent Corporation



11 OneClick for Admins — InstOneClick for Admins — Installing the Diligent Boalling the Diligent Boardsards

clientclient

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Video — Installing the Administrator Client

Youtube

Step-By-Step Instructions

1 Open Internet Explorer (or any web browser) and type in the web address for your site. This web address will be
provided by your Customer Success Manager.

2 On the website that appears, select the language you would like to use Diligent Boards in by selecting from the
Language menu at the upper right.

Note: To change the default language of this website, Diligent Boards OneClick and the Diligent Boards Admin
Client, contact your Customer Success Manager. The Diligent Boards Admin Client can be used in Simplified
Chinese, Dutch, English, French, German, Italian, Portuguese and Spanish.

3 Under My Computer, select Login. Diligent Boards OneClick will install on your computer and open
automatically.
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4 When the login screen appears, enter your administrator user name and case-sensitive password. Select Sign
In.
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Note: During your first login, a progress window will briefly appear as the application finishes installing.

5 If signing in for the first time, you will be prompted to Add an email address to your account. This makes it
easier for you to reset your password if you ever forget it.

6 Enter your email address and select Continue.

Note: You may also have the option to skip this step, if your organization's security policy allows it. If you skip
this step, you'll be asked to enter this information again after 24 hours. Your organization also controls the
number of times you'll be able to skip this step. After skipping this step enough times, entering this information
will become mandatory.
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7 After adding your email address, an email will be sent to that address containing a six-digit security code. Enter
that code in the field that appears and select Continue.
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8 If signing in for the first time, you will also be prompted to Complete your security questions.

Note: Security questions are used for identification purposes, and are required in the event of a password reset.
The security questions dialogue window will appear every time you sign in if your questions on file have not
been recorded.

9 Select the Select A Question field to view a list of available questions from which to choose.

10 Once you have selected a question, begin typing your answer in the field directly below the question. Answers
are not case sensitive, but must be at least 5 characters long, excluding spaces and non-alphanumeric characters.

11 Select Continue to save your questions and answers.
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12 If you administer multiple boards, select the board you want to access from the menu that appears.
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13 Depending on your settings, you may also see a list of committees associated with your site. Choose one now.
Diligent Boards OneClick is now installed on your computer. To open it in the future, on:

Windows 7: Select the Start Button in the lower-left-hand corner of the screen. In the menu that appears, select All
Programs, then Diligent Boards and Diligent OneClick.

Windows 8/10: Select the Start Button at the lower left to reveal either the Start menu or the Start screen. In either
case, type Diligent OneClick, and select the Diligent OneClick icon that appears.
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Note: If installation is not successful, use the “Click Here” link under “Problems Launching OneClick?” on the
installation web page. This will download an alternative Diligent Boards OneClick installer.

Note: To change the program’s language after it’s installed, uninstall the app and follow these instructions to
install it again. Make sure to pick the new language at Step 2.
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22 OneClick for Admins — Introducing the clientOneClick for Admins — Introducing the client

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

The Diligent Boards Admin Client is a PC-based tool where the entirety of your board materials can be
administered. From here, you can add, remove and edit documents; control who accesses those documents;
manage Contacts, Calendars and Questionnaires; and more.

1 Open Diligent Boards OneClick on your PC and type in your administrator user name and password. Select Sign
In.
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2 If you administer multiple boards or are on multiple committees, you may see a list of one or the other, or both,
upon login. Select the site and/or group you would like to access.
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Note: If you are on multiple boards with similar logos, hover your mouse over the logo to reveal the board’s full
name.

3 Diligent Boards OneClick will open with special administrator options. To go directly to the Admin home page,
select Admin Site on your site’s home page.

4 You can also access a variety of administrator tools directly from your site’s home page. Right-click anywhere
on the top menu bar where the calendar and contacts buttons are located. This will reveal a menu containing the
following sections:

Questionnaire Manager>
Create or Edit Contacts>
Edit Resource Center>

|
15 of 312 | Diligent Corporation



5 Right-click on a book to reveal a menu of administrative tools for that book. From this menu, you can go directly
to the following sections:

6 Select Show Hidden Books to reveal all unpublished books on the home page’s book list. This does not reveal
the books to directors—it only shows them to you, so you can edit and approve them.

Edit Calendar>
Create or Edit Books>
Edit Alert>

Open Book (Director View)>
Approve Book>
Edit Book Properties>
Copy and Rename Existing Book>
Show Hidden Books>
Edit Book>
Print Book>
Create Book from Scratch>
Order Books>
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33 OneClick for Admins — TOneClick for Admins — The admin home phe admin home paagege

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

The admin home page is the hub from which all administrative tasks can be accessed.

1 If your organization has just started to use Diligent Boards, the Admin home page may indicate that your site is
in Provisioning Mode. This means that your site is still being prepared by your Customer Success Manager, who
will have access to any content you add during the provisioning process. You will be contacted when your site
leaves provisioning mode, at which point Diligent will no longer have site access.

2 In Diligent Boards, every board and committee has all of its own materials. Each one has a separate Book List,
Calendar, Contacts List, Resource Center and Questionnaires. Select from the Board and Committee Menu to
change which board or committee you are currently administering.

Note: This list will only display the boards and committees you are authorized to access.

3 To change the meeting date displayed on the director’s home page, fill out the date entry field and select Save.

Note: If you do not see a date entry field, contact your Customer Success Manager.

4 Select Edit Contacts to add, remove and change entries in the Contacts List.

5 Select Edit Book to select the book you would like to work on.

6 To change Calendar entries, create new events or cancel meetings, select Edit Calendar.
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7 Select Edit Res. Center to modify your library of reference materials.

8 To create or modify questionnaires, or to see the results of questionnaires that have already been
published, select Manage Questionnaires.

9 To return to your site’s home page, select Main Home.

10 Selecting Admin Home at any time will return you to this admin home page.

11 Select Help to access this Customer Help Center. In addition to user guides, the Help Center contains tutorial
videos, information about what's new in Diligent Boards, and more.

12 Select Log-out when you are done administering your board materials. This helps maintain the security of your
data.
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44 OneClick for Admins — Enabling and editing alertsOneClick for Admins — Enabling and editing alerts

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Administrators are able to set an alert message that appears whenever anyone logs on to Diligent Boards
OneClick. This alert should contain important notifications that users must see.

1 Right-click anywhere on the top menu bar where the Calendar and Contacts buttons are located. Select Edit
Alert from the menu that appears.

2 Select the checkbox labeled Alert Disabled to turn on the alert. When alerts are on, this checkbox will read Alert
Enabled.

3 Add a title.

4 Type the text of the notification into the text field. You can also copy and paste the notification text from
Microsoft Word, with formatting left intact.

5 Make any additional formatting changes with the tool buttons provided:
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The Create a Link button allows for the creation of either hyperlinks to web-based content or QuickLinks to any
page of your board materials.

6 Select the Groups tab to change which users or groups will be shown the alert.

7 Select OK to save your changes to the alert.

8 To discard your changes, select Cancel.

9 The Delete button removes the alert entirely.

Font>
Bold>
Underline>
Highlight Color>
Center Align>
Decrease Indent>
Bulleted List>
Create a Link>
Font Size>
Italicize>
Text Color>
Left Align>
Right Align>
Increase Indent>
Numbered List>
Check Spelling>
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55 OneClick for Admins — CreaOneClick for Admins — Creating a new bookting a new book

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

This page describes how to initiate the book creation process and set up the properties of your book, including
book name, meeting dates, formatting options, and more.

1 On the Admin home page, select Edit Book.

2 Select Create Book.

3 Select Create Book From Scratch.
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4 The Create Book window will appear. On the Book Details tab, select the meeting Start Date and End Date from
the drop-down menus.

5 Enter a Title for the book. You may also add a Sub Title and Comments for the book. Any information entered
in the "Sub Title" and "Comments" fields will only be visible to directors on the OneClick desktop application.

6 The Book Status tab contains book visibility settings. By default, the Book Status is set to "Hidden," so directors
cannot view it while you are creating it. Do not change this setting for now. Later, the book can be published by
changing this setting to Current. After the meeting, the book can be set to Archived.

7 To adjust book formatting options, select the Book Options tab.

8 Tab Labeling options allow you to choose how tabs are labeled throughout the application: with standard
numbers, Roman numerals, lower case letters, or upper case letters. Select the drop-down for the tab level you
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wish to change the label style for, and make your choice. Tab labels can be modified in any combination, down to
four levels of tabs and sub tabs.

9 Select a Pagination option. Paginate by Book does not break the book into sections, and numbers pages
accordingly: a 100-page book will start at page 1 and end at page 100. Paginate by Tab will number pages by tab,
with the first page of every tab being a new page 1. Tabs are how a board book is typically broken up, with each
tab representing a different portion of the meeting.

10 To prevent directors from being able to print paper copies of the book, disable Allow Book to be Printed.

11 To prevent directors from being able to share notes with all other site users, disable Public Notes Enabled.

12 To prevent directors from being able to add comments on other users' notes, disable Allow Commenting.

13 To prevent directors from being able to individually select other users with whom to share notes, but to still
allow sharing with all site users, disable Allow Sharing.
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14 The Agenda Details tab allows you to configure information about the meeting for use with the Agenda
Builder feature.

15 The Conference tab allows you to add links for video conference meetings so that directors can quickly access
that information directly from the Current Books hub.

16 To edit book visibility for meeting groups, select the Groups tab. By default, users associated with the currently
selected board will be able to view this book when it is published, and administrators associated with the board
will be able to edit it. No other user will have any rights to the book.

17 To give another board group or committee access to view this book, select View. That group’s administrators
will also be able to view the book, but not edit it.

18 Select Edit by a group’s name to give that group full rights to the book. Directors from the group will be able to
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view the book, and administrators will be able to edit it.

19 Select No Access to ensure that no directors or administrators from that group can see or edit the book, unless
they are also in another group that does have access.

20 To edit book visibility for individual users, select the Users tab. This tab will let you hide the book from specific
users that have been given access via the Groups tab.

21 To disable this tab and only use group-based settings, select Use Groups security only.

22 If you need only a few specific people to be able to see this book, select Allow only specified users to view
book, then select the checkbox by each user that requires access.

23 If you need to block access to the book for a few specific people, select Do not allow specified users to view
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book, then select the checkbox by each user from whom you would like to hide the book.

24 Select OK. The Edit Book window will appear. Here, you can drag and drop a document folder or a bookmarked
PDF to quickly build out the contents of your book.
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66 OneClick for Admins — Adding conferencingOneClick for Admins — Adding conferencing

informainformation ttion to a booko a book

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Learn how to add video conference links to a meeting book's details, so that users can quickly access
conferencing information right from the bookshelf.

1 Open the "Edit Book Properties" window for a book by right-clicking on the book, then selecting Edit Book
Properties.
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Note: If you are creating a new book, follow the below steps in the "Create Book" dialog window.

2 Select the Conference tab.

3 Locate the conferencing information for your meeting. This information can usually be found in your calendar
application or email application, in the calendar invitation or email confirmation that you received after setting up
the meeting.

4 Select and copy all of the meeting details from your calendar or email application.
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5 Return to Diligent Boards, and, in the "Conference" tab, select Paste. Your meeting details will populate in the
blank "Include Remote Conference Details" field.
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Note: Using the "Paste" button within Diligent Boards ensures that all conference links will display as live,
selectable links for attendees.

6 If you do not need to update any other information for the book, select OK to save your changes. Otherwise,
continue editing other book properties as necessary.
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77 OneClick for Admins — Copying an existing bookOneClick for Admins — Copying an existing book

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

If you are creating a book for a new meeting that is similar in content or structure to the book of a previous
meeting, you can avoid starting from scratch by making a copy of the earlier book.

1 On the Admin home page, select Edit Book.

2 Select Create Book.

3 Select Copy and Rename Existing Book.
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4 The Copy Book window will appear. Select the Meeting Group that used the book you would like to copy.

5 Choose the book you would like to copy from the Select Book menu.

6 Enable the Copy Contents checkbox to copy the book in its entirety. If Copy Contents is disabled, only the book’s
tab structure and EasyEdit documents will be copied.

7 Select OK.

The Copy Book window will appear. This window is identical to the Create Book window. Continue creating the
book the same way you would a new book.
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88 OneClick for Admins — Changing the order of booksOneClick for Admins — Changing the order of books

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Administrators can control the order in which books are presented on all devices.

1 On your board’s home page, select the Current Books tab.

2 Right-click on or below any book and select Order Books from the menu that appears.
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3 To display the meeting books in chronological order, select Order by Meeting Date.

4 To manually change the order that books appear in, use the arrows next to each book to move it up or down.

5 Select Save to apply your changes.

6 To discard your changes, select Cancel.
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99 OneClick for Admins — MoOneClick for Admins — Moving a book tving a book to a differento a different

meeting groupmeeting group

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

This page describes how to change meeting group access permissions for a book that you have previously
created.

1 On your board's home page, use the Board and Committee menu to select a group that currently has access to
the book.

2 Next, right-click on the book you wish to move, then select Edit Book Properties from the list of options.
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3 Select the Groups tab to view your meeting groups and the access options that you assigned when you created
the book.

4 Use the radio buttons to change access permissions for groups as needed:

Note: At least one meeting group must have "Edit" access.

5 To apply your changes, select OK.

No Access: No one in the group can view or edit the book.>
View: Directors and administrators in the group can view the book, but administrators cannot edit it.>
Edit: Directors in the group can view the book, and administrators in the group can view and edit it.>
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1010 OneClick for Admins — Selecting a book from theOneClick for Admins — Selecting a book from the

home phome paagege

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Selecting a book opens it up in the Edit Book window, allowing you to view or modify its contents.

1 On your board’s home page, select the group the book belongs to from the Board and Committee Menu.

2 If the book is not visible in the Current Books list, right-click on or below the visible books and select Show
Hidden Books from the menu that appears.
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3 The hidden books will now be visible to you, but not to anyone else. The hidden books will appear semi-
transparent to indicate that others still cannot see them.

4 Right-click the book. Select Edit Book from the menu that appears. The book will open in the Edit Book window.
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1111 OneClick for Admins — Selecting a book from theOneClick for Admins — Selecting a book from the

admin home padmin home paagege

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Selecting a book opens it up in the Edit Book window, allowing you to view or modify its contents.

1 On the Admin home page, select the group the book belongs to from the Board and Committee Menu.

2 Select Edit Books.

3 Select Edit or Approve Book.
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4 Select a book from the menu that appears.

5 Select the Edit Book Name, Tabs, Levels button. The book will open in the Edit Book window.
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1212 OneClick for Admins — GaOneClick for Admins — Gathering bothering board documentsard documents

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Preparing materials for a board is easy with Diligent Boards. In just a few simple steps, a book can be created and
delivered instantly to directors. First, collect the documents needed for the book.

Note: If your book is already prepared as a single bookmarked PDF, you will be able to import it instead of a
folder, and do not have to gather any further documents.

1 Create a new folder. Name it something relevant to the meeting so that it’s easy to locate later.

2 Create some additional folders inside that folder. Name them each after a section of your board book, like
“Agenda,” “Minutes” or “Committee Reports.”

Note: You can skip this step if you know you will only have one document per board book section.

3 Collect the agenda for the upcoming meeting. The agenda will serve as a reminder of which documents are
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needed and how they should be presented. Place this document in the “Agenda” folder, if you created one.

4 Using the agenda, build a list of the documents needed for every stage ofthe meeting.

5 Collect the required digital documents. Diligent Boards will accept any of the following document types:

Microsoft Word (.doc, .dot, .docx, .docm, .dotx, .dotm, .rtf)>
Microsoft Excel (.xls, .xlt, .xlsx, .xlsm, .xltx, .xltm, .xlsb)>
Adobe PDF documents (.pdf)>
Common image formats (.gif, .jpg, .jpeg, .jpe, .png, .bmp, .tif, .tiff)>
Other document types (.xps, .html, .htm, .txt, .xml, .log)>
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1313 OneClick for Admins — Importing a new book from aOneClick for Admins — Importing a new book from a

folderfolder

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Adding collected documents to a new book is as easy as dragging and dropping a folder. The book will lay itself
out based on your selected settings.

1 Drag and drop the meeting folder that contains your documents into the Edit Book window. The Folder Import
Settings window will open.

2 Under Tab Structure, select Create Tab per Folder if you have made a sub folder for each section of the board
meeting. One tab will be created for each sub folder. If you have placed any documents in any of those sub folders,
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they will be placed in that sub folder’s tab.

3 Under Tab Structure, select Create Tab per File if you have made a single document for each section of the
board meeting. One tab will be created for each of these documents, as well as any sub folders.

4 Under Tab Numbers, select Numbered Tabs to sequentially number all of the tabs that will be created. Select
Non Numbered Tabs to remove the numbering.

5 If you are uploading any Excel workbooks, you can control which sheets within those workbooks will be
converted by selecting Select Excel Documents to have all their worksheets converted. Select every document
to ensure that all of the sheets are added to the book, or leave them unchecked to add only the last active sheet
in each file. Select OK when you’re done.

6 Select Advanced Import Options to reveal a menu of additional organization and conversion settings.
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7 Select Order Files Numerically if you have ordered your files by putting numbers at the beginning of every file
name. Your book will maintain this order. Select Remove any Leading Numbers from File Names if you would not
like these order numbers to be visible in your book structure. Numbers must be followed by a space (“1 Agenda”,
not “1-Agenda”) to be recognized.

8 Select Office®-Native Conversion options only if Microsoft Office documents are not importing into the book
correctly.

9 Select OK to save and close Advanced Options.
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10 Select Import. Your import will begin and run automatically in the background.
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1414 OneClick for Admins — Importing a new book from aOneClick for Admins — Importing a new book from a

bookmarked PDFbookmarked PDF

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Creating a new book is as easy as dragging and dropping a single bookmarked PDF. The book will lay itself out
based on that document’s bookmarks.

1 Drag and drop the bookmarked PDF into the Edit Book window. The PDF Import Settings window will open.

2 Under Tab Structure, select Create New Tab per Bookmark to recreate the bookmark structure of the PDF in
your board book. This is the best way to import a PDF that contains an entire board book.

3 Under Tab Structure, select Nest Content Under One Tab to place the entire contents of the PDF into a single
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board book tab; the PDF bookmarks will become sub tabs. This is the best way to add a PDF that only contains
content for one section of the meeting.

4 If you select Nest Content Under One Tab, you can title that tab by typing in the Tab Title field and selecting
Apply.

5 Under Tab Numbers, select Numbered Tabs to sequentially number all of the tabs that will be created. Select
Non Numbered Tabs to remove the numbering.

6 Select Import. Your import will begin and run automatically in the background.
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1515 OneClick for Admins — Importing a report fromOneClick for Admins — Importing a report from

Diligent EntitiesDiligent Entities

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

If your organization uses both Diligent Boards and Diligent Entities, you can send board books, in whole or in part,
directly and securely into Diligent Entities.

Note: This feature must be enabled by your Customer Success Manager.

1 Before using this feature in Diligent Boards, Diligent Entities must be configured with the user or entity that will
receive the documents. For steps on this configuration, review the Diligent Entities Help Center.

2 In Diligent Boards, navigate to and right-click on the required Book. A list of Book action options will appear.

3 Select Print Book.

|
57 of 312 | Diligent Corporation

https://support.icsasoftware.com/hc/articles/360030541472-Document-Sharing-Select-a-user-in-Diligent-Entities


4 Select the Export button located at in the bottom right-hand side of the screen.

5 Select the Export PDF – Blueprint from the menu that appears.

|
58 of 312 | Diligent Corporation



6 A dialog box will appear. Enter filename for the document to be exported into the File name field.

7 Select OK.
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8 A copy of the document will be shared with Diligent Entities. To locate it, in Diligent Entities, select the Data
Library icon in the Global Banner.

9 In the Type filter, select the Boards Meeting option and conduct a search to locate the document.

Note: You can also find the document by selecting the Working Documents icon in the Global Banner and in the
Where From filter, and then selecting the All Documents option to conduct a search and locate the document.

Diligent Entities helps organizations to centralize, manage and effectively structure their corporate record to
improve entity governance to better ensure compliance, mitigate risk and improve decision making through an
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integrated governance solution. Learn more about Diligent Entities.
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1616 OneClick for Admins — Using the edit book windoOneClick for Admins — Using the edit book windoww

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

The Edit Book window shows you the structure of the entire book. It also provides the tools for uploading, creating,
editing and approving board documents, and publishing the book when it’s complete. You can get to the Edit Book
window from the Home page or the Admin home page.

1 The main section of the Edit Book window displays the tabs of the book. By default these tabs are expanded
to display any associated uploaded documents, document placeholders and EasyEdit documents, as well as any
sub tabs.

2 Select Refresh Tabs to see any changes that another admin may have made to the book since you started
editing it.

3 Select Document Status to open a window displaying more information about the book, including who approved
which documents and upload dates.

4 Select Expand All Tabs to reveal all documents and placeholders in the book.

5 Select Collapse All Tabs to hide all documents and show only tab names.
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6 To expand or collapse a specific tab, select that tab’s Expand/Collapse button.

7 Select Edit Another Book to open the Edit Another Book side menu.

8 From the Edit Another Book menu, you can edit any of your board’s books or Resource Center items from
the same Edit Book window. Select the Current Books, Archived or Res. Center tabs, expand the date menu if
necessary, and select on the book you would like to edit.

9 Select the Hide Panel arrow to stop showing the Edit Another Book menu.
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1717 OneClick for Admins — Editing the book title and dOneClick for Admins — Editing the book title and daatete

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

A book’s properties, including its title and date, can be changed at any time if mistakes need to be corrected, or if
the parameters of the meeting change.

1 On the Edit Book window, select Edit Book Properties.

2 The Book Properties window will appear. On the Book Details tab, change the meeting Start Date and End Date
using the drop-down menus.

3 Enter a new Title for the book. You may also add a Sub Title and Comments for the book. All of this information

|
65 of 312 | Diligent Corporation



will be viewable by directors when the book is published.

4 You can also change any of the information in the Book Status, Book Options, Groups, and Users tabs. These
tabs behave the same way they did in the Create Book window that appears when Creating a New Book.
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1818 OneClick for Admins — Adding a blank or copied tOneClick for Admins — Adding a blank or copied tabab

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

A board book tab acts as a container for documents associated with a specific section of the meeting. Organized
tabs help ensure that all board materials are presented at the right time, in the right order.

1 There are multiple ways to add tabs to a book depending on where the tab should be located. In the Edit Book
window, select Add Tab At End to create a new tab that will appear after all previously created tabs.

2 Select the Insert Tab button on a tab or subtab that already exists to add a new tab directly before it. The button
is labeled with an up-facing arrow.

3 Select the Add Subtab button to add a new tab within an existing tab. The button is labeled with a right-facing
arrow. You can also add subtabs to other subtabs using this method.

4 Using any method to create a new tab will open the Create Tab window.

5 Enter a new Title for the tab. You may also add a Sub Title and Presenter name for the tab. All of this
information will be viewable by directors when the book is published.

6 Tabs are numbered based on the order in which they appear in the book. Check Non-Numbered Tab to remove
this numbering from a specific tab. This can be helpful if the tab contains documents that won’t be directly
addressed in the meeting presentations, like the agenda.
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7 If you need to make a tab that is similar in structure or content to an existing tab, select Copy Existing Tab. The
Copy Tab window will appear.

8 From this window, select the meeting group, then the meeting or Resource Center location that the tab resides
in, and then locate the tab in the list that appears. Select it and then select Copy. You will return to the Edit Book
view.
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9 If you do not need to copy a tab, you can continue Editing the tab manually or you can select OK and edit it later.
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1919 OneClick for Admins — Importing tOneClick for Admins — Importing tabs from a folderabs from a folder

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

If you have a folder of documents organized for a specific meeting section, you can import that folder as new tabs
into any position of an existing book.

1 Open the Create Tab window. See the previous page for more information.

2 In the Create Tab window, select Import Tab. The Import window will appear.

3 Drag and drop a folder into the Source Filename field, or find it with Browse.

4 Select Next >>. The Import Settings window will appear.
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5 The Upload Preview will show the tabs that will be added to the book in color. Existing tabs will appear in gray.

6 Under Tab Structure, select Create Tab per Folder if you have made a sub folder with documents for each tab in
this book section. Select Create Tab per File if you only have a single document for each tab.

7 Under Tab Numbers, select Numbered Tabs to sequentially number all of the tabs that will be created. Select
Non Numbered Tabs to remove the numbering.

Note: Tab number options are not available when you are importing sub tabs into an existing tab. The new sub
tabs will be numbered only if the parent tab is numbered.

8 Select Advanced Import Options to reveal a menu of additional settings.

|
71 of 312 | Diligent Corporation



9 Select Order Files Numerically if you start file names with order numbers. Select Remove any Leading Numbers
from File Names if you would not like these order numbers to be visible in your book. Numbers must be followed
by a space (“1 Agenda”, not “1-Agenda”) to be recognized.

10 Select Mark as New to advertise the document changes to the book’s readers, and to make the change appear
in the book’s update history. You may also add a description of the update to the Public Comment field.

11 Select OK to save and close Advanced Options.
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12 Select Import. Your import will begin and run automatically in the background.
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2020 OneClick for Admins — Importing tOneClick for Admins — Importing tabs from aabs from a

bookmarked PDFbookmarked PDF

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

If you have a bookmarked PDF for a specific meeting section, you can import that folder as new tabs into any
position of any existing book.

1 Open the Create Tab window. See the previous pages for more information.

2 In the Create Tab window, select Import Tab. The Import window will appear.

3 Drag and drop a bookmarked PDF into the Source Filename field, or select the Bookmarked PDF radio button
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and Browse for the folder.

4 Select Next >>. The Import Settings window will appear.

5 In the Upload Preview, existing tabs will be displayed in gray. The tabs displayed in color are what the current
Import will add to the book.

6 Under Tab Structure, select Create New Tab per Bookmark to recreate the bookmark structure of the PDF as
new tabs in the book. Select Nest Content Under One Tab to place the entire contents of the PDF into a single tab.

7 If you select Nest Content Under One Tab, you can title that tab by typing in the Tab Title field and selecting
Apply.

8 Under Tab Numbers, select Numbered Tabs to sequentially number all of the tabs that will be created. Select
Non Numbered Tabs to remove the numbering.

Note: Tab number options are not available when you are importing sub tabs into an existing tab. The new sub
tabs will be numbered only if the parent tab is numbered.

9 Select Advanced Import Options to reveal a menu of additional settings.
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10 Select Mark as New to advertise the document as a new document to the book’s readers, and to make the
change appear in the book’s Update History. You may also add a description of the update to the Public Comment
field.

11 Select OK to save and close Advanced Options.
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12 Select Import. Your import will begin and run automatically in the background.
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2121 OneClick for Admins — Editing and deleting a tOneClick for Admins — Editing and deleting a tabab

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Editing a tab allows you to create, manage and delete placeholder locations where documents can be created or
uploaded. You can also delete the tab entirely.

1 In the Edit Book window, select the Edit Tab button; it’s labeled with a pen icon. The Edit Tab window will appear.

Note: If you have just created a new tab, you can do all of this in the “Create Tab” window.

2 You may add or modify the Title of the tab. You may also add or modify the Sub Title and Presenter name. All
of this information may be viewable by directors when the book is published, though only the Title appears on
Diligent Boards for iPad.

3 Select Append Document to create a slot into which a document can be Uploaded. This step is optional, as you
can also drag and drop documents onto tabs in the Edit Book window. Use these slots as a reminder when you
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know where you will be placing a document that is not available yet.

4 Select Append EasyEdit Document to create a blank EasyEdit document. EasyEdit documents are fully editable
from within the Diligent Boards Admin Client. You can also import Microsoft Word documents into EasyEdit.

5 You may type in new or edit existing names for any document slot or EasyEdit document. This isn’t required, and
will only be visible to other administrators.

6 Select Insert Doc or Insert EasyEdit to insert a new document slot or blank EasyEdit document directly above
the chosen document location.

7 Select the X button to delete the document slot or EasyEdit document.

8 Use the Up and Down Arrows to rearrange the slots and blank documents.

9 Select Delete Tab to remove the tab and all of its documents from the book.

Note: If you are in the “Create Tab” window, select “Cancel” to delete the tab.

10 Select OK to save your changes to the book.
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2222 OneClick for Admins — Re-ordering tOneClick for Admins — Re-ordering tabsabs

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

A book’s tabs can be re-ordered at any time if mistakes need to be corrected, or if the scheduling order of the
meeting has changed.

1 In the Edit Book window, click and hold anywhere in a tab.

Note: Selecting “Collapse All Tabs” will hide all information except for tab names, which may help when re-
ordering a significant number of tabs.

2 While still holding down the mouse button, drag the tab until you see the blue Insert Tab line. This indicates the
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new location in which the tab will be placed.

When the Insert Tab line is in the right place, release the mouse button. The tab will move to its new position.
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2323 OneClick for Admins — TOneClick for Admins — The Ahe Agendgenda – Adding ana – Adding an

aagendgenda ta tabab

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

The agenda tab has several unique properties. When one is added to a book, every Diligent Boards client
application automatically generates multiple shortcuts and buttons that let directors return to the agenda from
nearly any other tab or page. The agenda tab is typically the first tab in a book.

Note: If you have already imported an agenda tab, and it is titled “Agenda,” you can skip these instructions.

1 If the book has no tabs, select Add Tab At End to create one. This will become the agenda tab.

2 If an agenda tab was not created when the book was first imported, in the Edit Book window, select the Insert
Tab Above button of the first tab in the book. This button is labeled with an up arrow. Selecting this arrow will add
a new tab to the beginning of the book, which will become the agenda tab.

3 If a tab for an agenda was created when the book was first imported, select the Edit Tab button associated with
it. The button is labeled with a pen icon.
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4 Choosing any one of the above steps will open either the Create Tab or Edit Tab windows. These windows are
similar, and the steps below apply to both.

5 Make sure the Title of the tab contains the word Agenda. This tells Diligent Boards to treat the tab as an agenda
tab. This title can be just the word “Agenda.”

Note: If you need an agenda tab that does not include the word “Agenda” in its title, contact your Customer
Success Manager.

6 Select OK to add the agenda tab to the book.
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2424 OneClick for Admins — TOneClick for Admins — The Ahe Agendgenda – Adding thea – Adding the

aagendgenda documenta document

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Once the agenda tab has been created, add the agenda document to it. Any agenda shortcuts that Diligent Boards
generates automatically will link to the first page of this document.

Note: If your agenda tab already contains an agenda document, you can skip these instructions, but you
may want to link each item in the agenda to its corresponding section of the book. See the instructions on
“QuickLinks” for more information.

Note: You can also create an agenda as an EasyEdit document, which may make it easier to modify later. See
the instructions on “Editing an EasyEdit Document” for more information.

1 Drag and drop the agenda document onto the agenda tab that was previously created. The text IMPORT NEW
DOCUMENT will appear in blue to let you know you are dragging the document to the right place. Release the
mouse button when you see this text.
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2 The Upload Document window will appear.

3 Select Upload (No Preview) to upload the agenda document to the book immediately.

4 Select Upload with Preview if you would like to see how the document will appear before committing to an
upload.
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Note: For more detailed information on the options available in the Upload Document window, see the
instructions on Uploading additional documents.

Note: Once the agenda document is in the document tab, linking each line item to the corresponding section of
the book can make the book much easier to use. See the instructions on QuickLinks for more information.
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2525 OneClick for Admins — AOneClick for Admins — Agendgenda Builder — Quicksta Builder — Quickstartart

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Agenda Builder streamlines your agenda creation process by using your book structure to set up a fully formatted
agenda within Diligent Boards. This page provides a quick overview of Agenda Builder functionality, with links to
more detailed, step-by-step pages.

1 While creating a book, enable the Use Agenda Builder checkbox in the Create Book window.

2 Use the Agenda Details tab to configure additional information about the meeting.
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3 As you build the book, use the Display Options dropdown in the Edit Tab window to control whether the tab
appears:

Both as an agenda item and a book section (Agenda & Book option)>
Only as an agenda item, such as a "Lunch" tab (Agenda Only option)>
Only as a book section, such as an appendix (Book Only option)>
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4 To generate the agenda, select the Attach Agenda option from the "Upload" menu in your agenda tab. You can
update the agenda at any time by selecting the "Refresh" option that appears next to the agenda document.
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For a detailed, step-by-step Agenda Builder walkthrough, visit the following pages:

1. Agenda Builder — Initial settings

2. Agenda Builder — Adding agenda items

3. Agenda Builder — The Agenda Builder screen

4. Agenda Builder — Generating and updating the agenda

5. Agenda Builder — The agenda document
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2626 OneClick for Admins — AOneClick for Admins — Agendgenda Builder — Initiala Builder — Initial

settingssettings

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

The Agenda Builder feature allows you to use your book structure to set up a fully formatted agenda document
within Diligent Boards. Agenda Builder can be enabled any time you initiate a new book (whether from scratch or
copied from an existing one), and can also be turned on while you're building a book.

Video — Getting Started with Agenda Builder

Youtube

Step-By-Step Instructions

1 Initiate a new book (from scratch or by copying an existing one), and configure it as you normally would. The
book Title and Meeting Date will appear on your agenda document.

2 Next, enable the Use Agenda Builder checkbox in the Create Book window.

3 Select the Agenda Details tab.
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4 Several settings and options will appear. The "Date" field will be populated automatically with the date of your
meeting (and if your meeting has a different start and end date, each day of the meeting will appear on a separate
line). In the Start Time and End Time columns, you can manually type in a time, or use the arrows to adjust.

5 Use the Time Zone drop-down to adjust the time zone displayed on the agenda, if necessary. If your site only
lists one time zone, it won't display on the agenda.

Note: If you require a time zone that isn't listed, contact Diligent to have that time zone added as an option for
your site.

6 To display a logo on the agenda, enable the Include Logo option.

6a To display your default site logo on the agenda, enable the Use Site Logo option.
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6b To upload a different logo to display on the agenda, enable the Use Different Logo option, then select the
"Select File" option to choose an image file to upload. It is recommended that the selected file not exceed 304
pixels x 73 pixels.

7 Enable Show Page Numbers if you would like to display the starting page numbers for each section on the
agenda.

8 If you would like the meeting end time to display on the agenda, leave the Show Meeting End Time option
enabled. To hide the meeting end time, deselect this option.

9 In the Meeting Information field, you can enter details about the meeting, such as the location. Any text entered
here will appear in the header of your agenda document, above the agenda items.
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10 Scroll down to find the Additional Notes field. Any text entered here will appear at the end of your agenda
document, below all agenda items. This field is useful for meal information or directions to the venue.

Note: The "Meeting Information" and "Additional Notes" fields are optional. All information on this tab can be
edited later through the "Edit Book Properties" button in the Edit Book screen.

11 Select OK to proceed to the Book Editor screen.
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In the next step, you'll begin adding tabs and content to your book and agenda. Go here to proceed.

Did you know? If you collaborate with other stakeholders while building the agenda, you can use Diligent
Messenger to securely discuss details, updates and changes, ensuring that sensitive meeting information
remains confidential. Learn more about Diligent Messenger here.
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2727 OneClick for Admins — AOneClick for Admins — Agendgenda Builder — Addinga Builder — Adding

aagendgenda itemsa items

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Agenda Builder allows you to designate tabs to appear in both the agenda and the book, only in the agenda, or
only in the book. Additional information can also be added for items that appear on the agenda.

1 Agenda Builder information can be added and edited for tabs that have been created from scratch, or that have
been imported into the book from a folder or PDF. This information can also be edited at any time. Select the Edit
Tab button for a tab to begin setting up Agenda Builder options.

2 Select the Display Options drop-down arrow to see your available options. By default, this field is set to Agenda
and Book, meaning that the tab will appear as a section in the book (to which documents can be added), as well
as an item on the agenda.

3 Choose Book Only if the tab should only appear in the book, but not as an agenda item. This option might apply
to the Agenda section of the book, as well as any Appendix sections.
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4 Choose Agenda Only if the tab should only appear as an agenda item, but not as a book section. Documents
cannot be added to Agenda Only items. This option is typically used for meals and breaks.

5 Enable the Non-Numbered Tab checkbox if this tab should not be factored into tab numbering. This option is
useful for "Book Only" tabs when tab numbering is being used for other tabs, to ensure that numbering remains
consistent.

6 Select the Agenda Details tab to add more information for items that appear on the agenda.

7 Enter a name or names in the Presenter field, if applicable. This text will appear in the "Presenter" column of the
agenda document.

8 Enter an optional Description of the agenda item. This text will appear directly below the item name on the
agenda document.

9 In the Duration section, use the arrows or manually type a duration into the Hours and Minutes fields. This
information will be used to generate a start and end time for the item, which will appear on the agenda document.

Note: Start and end times appear in a "Time" column on the agenda document. To exclude this column, leave
the Duration fields empty for each tab.
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Note: Start and end times shown on the agenda are calculated based on the Start Time of the meeting, and
the duration entered for the preceding agenda items. For multi-day meetings, the End Time set for each day
determines the point at which items begin appearing on the following day.

10 Select OK to finish editing the tab and apply your settings, then repeat this process for each tab of the book.

You can review agenda information and display settings at a glance on the Agenda Builder screen. Go here to
proceed.
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2828 OneClick for Admins — AOneClick for Admins — Agendgenda Builder — Ta Builder — The Ahe Agendgendaa

Builder screenBuilder screen

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

The Agenda Builder screen allows you to review how items will appear on the agenda. On this screen, you can
view tab display options and agenda item information at a glance, and can also edit these details.

Tip: If you haven't yet configured the initial Agenda Builder settings for your book, go here to learn how.

1 Select the Agenda Builder toggle button near the top of the Edit Book window to view the Agenda Builder screen.

2 All tabs will appear here, regardless of their display status. The Display Option for each tab appears in the tab
header, to the left of the tab name.

3 Any information added on the Agenda Details tab also appears on this screen.

4 To edit tab options, including display options, select the Edit Tab button. All options are identical to those
accessed from the Book Editor screen.

5 Select the Book Editor toggle button to return to the Book Editor screen when you're ready to generate your
agenda document.
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Go here to learn how to generate and update your agenda document.

Did you know? You can send notifications about agenda updates at any time while building the book, using the
"New Notification" button. Notifications can be sent via email, push notification, and Diligent Messenger. Go
here to learn more.
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2929 OneClick for Admins — AOneClick for Admins — Agendgenda Builder — Generaa Builder — Generatingting

and updand updaating the ating the agendgendaa

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

You can generate an agenda at any time during the book creation process. If you make additional changes to the
book, simply select the "Refresh" button next to the agenda document to update it.

1 To generate the agenda document and add it to your book, select the down arrow that appears next to the
"Upload" (or "Replace") option for the tab or document placeholder to which you would like to add it.

2 Select Attach Agenda from the menu options.

3 An upload dialog box will appear, with several standard document upload options. Adjust any options as
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necessary, then select the Upload button of your choice to generate and upload the agenda. You can then access
and view the agenda document like any other document in a book.

4 Select View to review your agenda at any time. See the agenda document page for more information about the
agenda document, including a quick reference on how to edit each aspect of it.

5 If you make additional changes to the book, select the Refresh button that appears next to the agenda
document. An alert will also appear, which you can select to refresh the agenda.

6 Once you're satisfied with your agenda document, you're ready to publish your book just as you would any other
book. Select Approve This Book to get started.
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Did you know? Additional book-building automation tools, including secure collection of documents, collation,
and review, are available as well. Learn more about Secure Meeting Workflow.
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3030 OneClick for Admins — AOneClick for Admins — Agendgenda Builder — Ta Builder — The ahe agendgendaa

documentdocument

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

The agenda document contains the information that you added in each step of the agenda creation process. This
page serves as a quick reference for how to edit each area of the agenda document.

1 Logo (optional): Edit Book Properties button (or Create Book dialog) > Agenda Details tab > Include Site Logo
checkbox

2 Document Title: Edit Book Properties button (or Create Book dialog) > Book Details tab > Title field

3 Information below title (optional): Edit Book Properties button (or Create Book dialog) > Agenda Details tab >
Meeting Information field

4 Meeting Date: Edit Book Properties button (or Create Book dialog) > Book Details tab > Meeting Start Date

Note: For multi-day meetings, the document will include each day included from the Start Date to the End Date,
along with the Start Time for each day. The End Time set for each day, along with the duration of individual
agenda items, determines the flow of items from one day to the next.

5 Meeting Time: Edit Book Properties button (or Create Book dialog) > Agenda Details tab > Start Time

Note: For multi-day meetings, Start Times can be set for each day from this tab, and each will be shown on the
agenda.

6 Meeting Time Zone: Edit Book Properties button (or Create Book dialog) > Agenda Details tab > Time Zone
drop-down
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7 Agenda Item Numbers:

8 Agenda Item Name: Edit Tab button > Tab Details tab > Title field

9a Linked Agenda Item: Edit Tab button > Tab Details tab > Display Options drop-down > Agenda and Book

Note: An "Agenda and Book" tab must have one or more documents added to it via the Book Editor in order to
be linked.

9b Unlinked, Unnumbered Agenda Item: Edit Tab button > Tab Details tab > Display Options drop-down > Agenda
Only

9c To Exclude an Item from the Agenda: Edit Tab button > Tab Details tab > Display Options drop-down > Book

To enable or disable in bulk when importing a book from a folder: Import Settings dialog > Tab Numbers
options

>

To control numbering for individual tabs: Edit Tab button > Tab Details tab > Non-Numbered Tab checkbox>
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Only

10 Agenda Item description (optional): Edit Tab button > Agenda Details tab > Description field

11 Presenter (optional): Edit Tab button > Agenda Details tab > Presenter field

12 Time (optional): Edit Tab button > Agenda Details tab > Duration (Hours and Minutes fields)

Note: To hide the "Time" column, do not enter a duration for any tab.

Note: The start and end times shown on the agenda document are calculated based on the start time of the
meeting set in Book Properties, and the duration set for preceding agenda items. For multi-day meetings, the
End Time set for each day determines the point at which items begin appearing on the following day.

13 Page (optional): Edit Book Properties button (or Create Book dialog) > Agenda Details tab > Show Page
Numbers checkbox
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14 Additional information (optional): Edit Book Properties button (or Create Book dialog) > Agenda Details tab >
Additional Notes field

Did you know? Additional book-building automation tools, including secure collection of documents, collation,
and review, are available as well. Learn more about Secure Meeting Workflow.
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3131 OneClick for Admins — Publishing, hiding andOneClick for Admins — Publishing, hiding and

archiving booksarchiving books

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

By changing the status of a book, you can control whether a book is published to directors, hidden so only
administrators can see it, or archived so it can be viewed as a legacy document. None of these settings are
permanent; they can be changed at any time.

1 In the Edit Book window, select the Book Status button.

2 The Edit Book Properties window will appear, with the Book Status tab open.

3 To keep the book hidden from directors, select Hidden. Choose this option if the book is not yet complete, or
has not yet been approved for publication.

4 To publish the book to directors, select Current. Setting the book to Current allows all directors to view and
annotate the book.

Note: When you set a book to current, you'll be asked if you want to send a notification about its availability to
directors via email, push notification, or securely via Diligent Messenger. Learn more about notifications here.

5 Select Archived to add the book to the Archived Books section. Directors will be able to view this book but
will not be able to add any further annotations. Choose this option if the meeting the book was for has already
occurred, and the book is now a legacy document.
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6 Check Accessible Offline (OneClick) to make the archived book downloadable for use without an internet
connection in Diligent Boards OneClick. Archived books require an internet connection on Diligent Boards mobile
apps (iOS, Windows, and Android) regardless of this setting.

Did you know? World-class security starts once you upload your book to Diligent Boards, but the steps leading
up to book creation are often done through unsecured channels. For end-to-end protection of your meeting
preparation and communication, learn more about Secure Meeting Workflow here.
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3232 OneClick for Admins — Sending noOneClick for Admins — Sending notificatifications abouttions about

new booksnew books

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Once a book is published, a notification can immediately be sent to any and all book readers letting them know
about it. Notifications can be sent via email, push notification, or securely via Diligent Messenger, and additional
messages about the book can be sent at any time.

1 After publishing a book by selecting “Current” in book options, enable the Send Notification checkbox.

Note: This checkbox will not appear if the book is already set to “Current.” If the book isn’t published but you
still don’t see this checkbox, notifications have not been enabled for your site. Contact your Customer Success
Manager for assistance.

2 Select the OK button. The book will be published and the notification editor will appear.
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3 The notification will contain a default subject line and message text. You can customize this text now.

Note: To change the default subject and text, contact your Customer Success Manager.

4 To notify users via email, make sure Notify by Email is checked.

5 To send the notification via Diligent Messenger, enable the checkbox labeled Notify by Messenger. Enabling
both boxes will send the notification via both methods simultaneously.

6 To send the announcement as a push notification to Diligent Boards for iOS, check Send Push Notification. Push
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Notifications must be enabled for your site.

7 Select Send me a copy to email yourself a copy of the message.

8 To check your message for typos, select the Spellcheck button.

9 The To: field contains a list of everyone who is eligible to see the book. By default, everyone on this list with a
Diligent Messenger account or email address on file will receive the notification. To change this list, select the To:
button.

10 Enable or disable the boxes by each user’s name to add or remove them from the notification.

11 To add or remove the user from just the email version of the notification, enable or disable the Address
checkbox associated with the user.

Note: If a user doesn’t have an email address on file, they will still appear in this list. See the section on Editing
Contact Information to learn how to add an email address.
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12 To add or remove the user from just the Diligent Messenger version of the notification, enable or disable the
Messenger checkbox associated with the user.

Note: If a user doesn’t have Diligent Messenger enabled, they will still appear in this list but cannot be added
to the Messenger version of the notification. Contact your Customer Success Manager to obtain a Messenger
license for this user.

13 A "phone" icon indicates users who have registered to receive push notifications. All users with this icon will
be notified if you enable the "Send Notification" box in Step 6. Push notifications cannot be tailored per user.

14 To send the notification to any email address, type the address into the Additional Recipients field. You can
enter any number of email addresses here, separated by semicolons.

15 Select the OK button to return to the notification.

16 When the message is ready, select Send. Via email, the message will have your name as the sender, and will
come from a "diligent.com" email domain. You will receive any replies to this message (including error alerts), if
you have an email address on file. Via Diligent Messenger, the message will appear in the notifications list of the
meeting group associated with the book.
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Note: If you don’t have an email address on file, you won’t be able to send a notification via email. See the
section on Editing Contact Information for instructions on adding your email address to your Diligent profile.

17 To see a record of all sent notifications, select the Notifications tab in the Book Properties window (this is the
same window where you set the book to “Current” status). A list of all previously sent notifications will appear.

18 Each Notification Record will display the date and time at which the notification was sent, as well as the name
of the administrator who sent it. To see a read-only copy of the notification, select the record.

19 You can send a notification at any time by selecting the New Notification button.
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20 You can also send a notification from the Edit Book window by selecting the New Notification button.
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Did you know? Diligent Messenger is a secure email alternative and texting solution that can protect your most
sensitive board communications with trusted Diligent security. Learn more.
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3333 OneClick for Admins — Deleting a bookOneClick for Admins — Deleting a book

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

A book can be deleted in its entirety if it is no longer needed.

1 On your board’s home page, select the group the book belongs to from the Board and Committee Menu.

2 To delete a current book, select the Current Books tab. Switch to the Archived Books tab if you want to delete
a book in the archive.

3 Right-click the book you want to delete. Select Edit Book Properties from the menu that appears.
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4 If the Delete Book button does not appear in the lower left of the window, change the Book Status to Hidden, then
select OK to close the window. The Delete Book button should appear when you re-open the Edit Book Properties
window.

Note: After hiding the book, you may have to enable “Show Hidden Books” to make it appear again. To do this,
right-click anywhere in the book list and select “Show Hidden Books” from the menu that appears.

5 Select the Delete Book button. You will have to confirm your choice.
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3434 OneClick for Admins — UplOneClick for Admins — Uplooading additionalading additional

documentsdocuments

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Adding documents into the book after it has been created is as easy as dragging and dropping.

1 To add new documents, drag and drop them onto any existing book tab. You can drag documents above, below
or between any documents that are already in the tab, as well as onto empty tabs. If you select and drag multiple
documents at once, they will all be placed in that location. The following document types are supported:

Note: Documents can be dragged from local storage (such as the “My Documents” folder) and network drives.
You can also drag and drop email attachments from Microsoft Outlook.

2 If you previously created an empty document slot as a reminder, you can also drag and drop a single document
directly into the slot.

3 As an alternative to dragging and dropping, you can also select the Upload button next to an existing empty
document slot in the Edit Book window.

Regardless of the method you choose to add documents to the book, the Upload window will open.

Microsoft Word (.doc, .dot, .docx, .docm, .dotx, .dotm, .rtf)>
Microsoft Excel (.xls, .xlt, .xlsx, .xlsm, .xltx, .xltm, .xlsb)>
Microsoft PowerPoint (.ppt, .pot, .pps, .pptx, .pptm, .potx, .potm, .ppsx, .ppsm)>
Adobe PDF documents (.pdf)>
Common image formats (.gif, .jpg, .jpeg, .jpe, .png, .bmp, .tif, .tiff)>
Other document types (.xps, .html, .htm, .txt, .xml, .log)>
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Note: If you use the Diligent Minutes module, you can upload documents directly from Minutes to Boards via
the "Upload" menu. Select "Import Minutes" from the "Upload" menu to open an import dialog.

Note: You can prevent the Upload window from appearing by holding down the CTRL button while dragging and
dropping documents into the book. Instead, every document will import using the default settings.

4 If you dragged and dropped a document into the book, the Source Filename field will be filled out. Skip to step
6. If the field is empty, select Browse to find your document.
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Note: If you dragged and dropped multiple documents at once, you will not be able to change the Source
Filename field.

5 A Windows Explorer window will open. Select your file in this window and select Open.
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6 In the Upload window, check Mark As New to publicize the document as new to the book’s readers, and to make
the change appear in the book’s update history. If you do not check this box, the update will not be publicized.

7 If you select Mark As New, you may add a description of the update to the Public Comment field. This comment
will appear in the update history of the book.

Note: If you dragged and dropped multiple documents at once, the public comment may appear in update
history multiple times.

8 You may add a Private Comment. This comment will only be shared with other administrators of the book.

9 If you upload one or more Excel spreadsheets, the Convert all sheets in spreadsheet option will appear. Check
this box to make each sheet in every Excel document appear as a separate page in the book.

10 Select Upload (No Preview) to upload the document to the book immediately.

11 Select Upload with Preview if you would like to see how the document will appear before committing to an
upload, or if you would like to approve the document immediately.
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Note: If a document looks correct in Microsoft Office but looks incorrect in Diligent Boards, try converting the
document to a PDF and uploading it again. This will resolve many issues, including some font problems.
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3535 OneClick for Admins — Previewing an uplOneClick for Admins — Previewing an uplooadedaded

documentdocument

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Uploading with a preview allows you to check a document before committing it to a book. It also gives you the
option to approve it immediately.

1 While uploading a document in the Upload or Replace windows, select Upload with Preview. You will be returned
to the Edit Book window.

2 In the Edit Book window, select Preview by the uploaded document.
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3 The document will open for preview. Type in a page number and select Go or use the Left and Right Arrows to
page through the document.

4 Use the Zoom options to change the appearance of the preview.

5 Print the document to preview how it would appear on paper.

6 If the document appears correct, select Post to Book to add the document and complete the upload process.

7 If the document appears correct and has been fully approved for addition to the book, select Post to Book and
Approve. This will make the document visible to all readers when the book is published.

Note: Select the drop-down arrow by the “Post to Book and Approve” button to choose between “Approve Final”
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and “Approve Not Final.” “Approve Not Final” is optional functionality. Contact your Customer Success Manager
if you would like this option to be enabled or disabled.

8 If the document has errors that only appeared during upload, select Reconvert to attempt to resolve them. If
this does not resolve the issue, try saving the document as a PDF and uploading that instead, or contact your
Customer Success Manager or Diligent Global Support.

9 Select Delete and Start Over to delete the document from the book. The document slot will remain empty.
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3636 OneClick for Admins — UpdOneClick for Admins — Updaating or replating or replacing acing a

documentdocument

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Replacing a document with a newer or revised version is similar to uploading an original document. The optional
Note Saver feature allows you to ensure that directors won't lose any notes they've added, even when a document
is replaced. Learn more about Note Saver.

1 You can replace a document by dragging and dropping a newer version on top of it, into the same document slot
in the Edit Book window.

2 Alternatively, you can select the Replace button next to the original document.

Note: The "Replace" menu contains an "Import Minutes" option. If you use the Diligent Minutes module, you can
upload documents directly from Minutes to Boards with this option.

3 The Replace window will open. Check Mark As Revised to publicize the document as an updated document
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to the book’s readers, and to make the change appear in the book’s update history. If you do not check this, the
update will not be publicized.

Note: If you are replacing a document that has not yet been approved, you will have the option to select “Mark
As Revised” or “Mark As New.” You can check one or the other, but not both. This will publicize the change to
readers as either a brand-new document or as an update to an existing document.

4 If you select Mark As New or Mark As Revised, you may add a description ofthe update to the Public Comment
field. This comment will appear in the update history of the book.

5 Select Transfer notes/annotations to new document to ensure that all readers’ notes, highlights and markups
are not removed when the page is updated. To make sure these markups still appear on the relevant part of
the page, only select this if the new document is changed slightly from the old one — for example, if you only
fixed typos. This option will only work if the new document has the same number of pages, page size and page
orientation as the old document.
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Note: If you do not (or cannot) use “Transfer notes/annotations to new document,” the Note Saver feature can
instead automatically create copies of any replaced annotated page for all of your board members. They can
then move all notes and markups back into the book as needed. To enable both “Transfer notes/annotations to
new document” and Note Saver on your site, contact your Customer Success Manager.

The rest of the Replace window is identical to the Upload window. Consult the instructions on Uploading
Documents for further information.
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3737 OneClick for Admins — UpdOneClick for Admins — Updaate Histte Historyory

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

When you mark a document as new or revised, that mark and any associated public comments will appear in the
book’s update history. How update history appears to a book’s readers depends on how they view the book.

1 On Diligent Boards for iPad and Diligent Boards for Windows, an icon will appear on the bookshelf indicating that
there have been updates since the last time the book was read. Selecting that icon will reveal the book’s update
history, any associated public notes and additional information about the update, including when the document
was updated and what pages are affected.

2 On Diligent Boards OneClick, holding the mouse over the book will reveal its list of tabs. Tabs that have been
revised since the last time the book was read will be marked, and the affected pages will be noted. The associated
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public notes will not be displayed.
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3838 OneClick for Admins — Rearranging documentsOneClick for Admins — Rearranging documents

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Documents already in a book tab can be dragged and dropped in any order.

1 To move a document to a new position in its tab, select and hold that document’s file name.

2 While still holding down the mouse button, drag the document until you see the blue INSERT DOCUMENT line.
This indicates the new location in which the document will be placed. When the INSERT DOCUMENT line is in the
right place, release the mouse button. The document will move to its new position.
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Note: While documents can be arranged within a tab, they cannot be moved between tabs. To move a document
to a new tab, delete it from its current location and add a new copy to the book.
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3939 OneClick for Admins — Hiding or deletingOneClick for Admins — Hiding or deleting

documentsdocuments

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Hiding a document or tab provides multiple methods to ensure only specific users can view certain items when
the book is published.

1 In the Edit Book window, go to the document and select More.

2 To remove the document from the book completely, select Delete in the Edit Book window.

3 To hide the document, select Hide. The Hide Document window will appear.
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4 To choose which users will be the only ones able to see the document, select Allow only specified users to view
document.

5 To prevent specific readers from viewing the document, select Do not allow specified users to view document.

6 In the user list, check the boxes by each person’s name:

7 Select Select All to check off every user at once.

8 Select Deselect All to clear the checkboxes from the user list and start over.

9 Select OK. When the book is published, your selected hiding option will apply.

If you selected Allow only specified users to view document, the users you check will be the only ones who
can view the document. No one else will be able to see it.

>

If you selected Do not allow specified users to view document, the users you check will not be able to see the
document, but everyone else will.

>
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10 To hide the entire tab the document is in instead, select View by the document. The page view window will
open.

11 Select Hide Content.

12 In the menu that appears, select The Entire Tab. Follow steps 4–9 to apply hiding options to every document
in the tab at once.
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Note: Administrators cannot have documents or tabs hidden from them. They will always be able to see
everything in the books they administer.
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4040 OneClick for Admins — EasyEdit — Getting stOneClick for Admins — EasyEdit — Getting startedarted

and the Home tand the Home tabab

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

EasyEdit is a fully featured word processor that allows for documents to be created and edited from within the
Diligent Boards Admin client, so you don’t have to save and re-upload every time a change is made.

1 In the Edit Book window, select EasyEdit next to an EasyEdit slot.

Note: To add an EasyEdit slot to a tab, select “Edit Tab,” followed by either the “Insert EasyEdit Document”
or “Append EasyEdit” buttons. See the instructions on Editing and deleting a tab for more information.

2 The Edit EasyEdit window will appear. The Home tab is selected by default.

3 The home tab contains many typical document creation and styling features. The Clipboard section contains
options to cut, copy, paste and paste special (which allows you to remove formatting from text before pasting it).

Note: Copying and pasting from Microsoft Word will maintain most text formatting. The standard keyboard
commands Ctrl+C for copy and Ctrl+V for paste work as well.
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4 The Font section contains a variety of options for styling text, from upper-left to lower-right:

5 Select the arrow in the lower-right of the font section to open the Font Dialog Box.

This box contains additional font options, including:

Font selection>
Font size>
Grow/shrink font size>
Change case on selected text>
Bold>
Italicize>
Underline/double underline>
Strikethrough/double strike>
Superscript/subscript>
Font/highlight color>
Clear formatting on text>
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5a Additional underline styles

5b Colors for underlines only

5c Underline words only, not spaces

5d Hide text

6 The Paragraph section contains a variety of options for formatting paragraphs, from upper-left to lower-right:

7 Select the arrow in the lower-right of the paragraph section to open the Paragraph Dialog Box.
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8 In the paragraph dialog box, select the Indents and Spacing tab for more detailed control over text alignment,
indentation and line spacing.
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9 Select the Line and Page Breaks tab.

9a Select Keep lines together to keep a paragraph from being broken up by a page break.

9b Select Page break before to put a full page before the paragraph.

10 To customize how tabbing works in the document, select the Tabs... button
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11 Add numbers to the Tab Stop Position list to indicate where, in inches across the page, the cursor will go when
tab is pressed on the keyboard.

12 Default Tab Stops indicate where tabs will go by default. If this number is 0.5”, tabs will be placed every half
inch on the page.

13 Set Alignment to change whether the tab should indicate the start (Left), the end (Right), or the Center of the
text, or, in a number with a Decimal, the placement of the decimal point.

14 Set a Leader to change the symbol that will repeat before the tab, if any.

15 Set adds your custom tab stops to the list. You can also Clear the selected tab stop, or Clear All tab stops.

16 Select OK to save your tab settings.
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17 The Styles section contains a set of preset styles — buttons that change text, paragraph and tab styles
simultaneously.

18 Select some text and select any Style button to apply that style to the text.

19 To see how the style has been set, or to change these settings, select the arrow in the lower-right of the styles
section to open the Style Dialog Box.
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20 To change the style you’re editing, select from the Current Style list.

21 You’re able to change the Name of the style, and the Style It’s Based On.

22 The Formatting section contains a subset of font and paragraph options that can be set for the style.

23 For a complete set of font, paragraph and tab options, select the Format button and choose from the list. Any
option you change will be applied to the style.

24 Select OK to save your changes to the style.
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25 Select Spelling to spell check any text selected in the document, or the entire document if nothing is selected.

26 Select Find or press Ctrl+F on your keyboard to find text in the document.
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27 Enter your search term into the Find field.

28 You can choose if you want to find the term below or above the cursor, or search the entire document.

29 You can also choose to find terms with the exact same case, or if it should only look for whole words and not
the same term within a word.

30 Select Find Next to find the term. Select it again to find the term in another place.
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31 Select Replace or press Ctrl+R on your keyboard to find and replace text.
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32 Replacing is similar to finding. Enter a term in the Replace With field.

33 After using the Find Next button to find a search term, use the Replace button to replace that instance of the
term with the term in the Replace With field.

34 Use the Replace All button to replace every instance of the search term with the term in the Replace With field.
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4141 OneClick for Admins — EasyEdit — TOneClick for Admins — EasyEdit — The Insert the Insert tabab

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

1 The Insert tab contains many options for inserting various types of content into your document.

2 Select Page Break to add a new page below the current cursor location.

3 Select Table and select the starting number of rows and columns to add a spreadsheet-like table to the
document.

Note: See the EasyEdit — Inserted tables for more information on table options.

4 Select Inline Picture to select an image from your computer and place it inline into your document text. Text
and other objects will flow around the image.

5 Select Picture to select an image from your computer and place it onto your document. You’ll be able to move
this image anywhere, including over text.

Note: Supported image types include .BMP, .DIB, .JPG, .PNG, .GIF, .TIF, .EMF and .WMF.

6 Select and drag the square at the center of an image edge to stretch the image.

7 Select and drag the corner of an image to scale it without distorting it.
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8 Use the QuickLink button to turn selected text into a link to another document or external website. See the
section on QuickLinks for more information.

9 Use the Headers and Footers buttons to add these items to every page.

10 The Page Number and Page Count buttons add these numbers to headers and footers, respectively. Page
numbers and page counts can only be added to headers and footers.

11 Select Text Box to add a text box to the page that can be moved anywhere, including over text. This text box
can be stretched like a picture.

12 To add special characters, select Symbol to open the symbol window.
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13 Select the Font in which you’d like the symbol to appear.

14 Choose the symbol from the character list.

15 Select OK to add the symbol to the document.
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4242 OneClick for Admins — EasyEdit — Inserted tOneClick for Admins — EasyEdit — Inserted tables —ables —

DesignDesign

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

1 While editing an insert table, two new tabs will appear. To modify the appearance of the table, select the Design
tab.

2 Table Styles apply styling to entire table at once. Select any style to apply it to the current table.

3 To create New or Modify Existing table styles, select the arrow at the bottom-right of the style list and choose
from the menu. You can also Delete styles.
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4 Name your style, and choose if it should be Based On an existing style.

5 Before choosing your style settings, use Apply formatting to choose what section of the table will be styled.
For example, you can style the entire table at once using “Whole Table,” or choose styling for just header or footer
rows.

6 Font choices let you pick font style, size and color, as well as basic formatting.

7 Cell Style options let you choose (from left to right) the style, thickness and color of the cell border, the part of
the border the style should be applied to, the color of the cell, and how text should be aligned in the cell.

8 For a complete set of font, paragraph and tab options, select the Format button and choose from the list. Any
option you change will be applied to the style.

9 Select OK to save your styles, or any changes you have made to a style.
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10 Under Table Style Options, select Header Row and Total Row to apply those settings from your selected table
style. First Column and Last Column provide the same functionality for columns. If you leave these unchecked,
these parts of the table will be styled using the “Whole Table” setting.

11 If your table style includes styling for Banded Rows and Banded Columns, selecting the Table Style Options
for those banded rows and columns will cause that styling to be displayed. Uncheck these to style these sections
with the default “Whole Table” style.

12 If you want to style just a part of the table in a certain way, highlight those cells and use the Borders & Shadings
settings. These settings control line style and weight, line color, which part of the border should be styled, and
cell color.

13 After choosing line style, weight and color (using “Pen Color”), select the Border style to apply those settings.
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4343 OneClick for Admins — EasyEdit — Inserted tOneClick for Admins — EasyEdit — Inserted tables –ables –

LaLayyoutout

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

1 While editing an insert table, two new tabs will appear. To modify the structure of the table, select the Layout
tab.

2 Select lets you highlight the cell, row or column the cursor is in. You can also select the whole table.

3 View Gridlines displays the location of any cell edges that may have been made invisible by style choices. These
lines still won’t appear in the book.

4 Properties lets you set default height, width and alignment options for rows, columns, cells or the entire table.

5 Delete lets you delete the cell, row or column the cursor is in. You can also delete the whole table.

6 The remaining buttons in the Rows & Columns section let you insert rows Above or Below the currently selected
cell. You can also insert columns to the Left or Right of the selected cell.
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7 To create a large cell that spans across multiple rows and/or columns, select the cells you want to combine and
then select Merge Cells.

8 To segment cells into smaller cells, highlight the cells you want to separate and select Split Cells. You’ll get to
choose how many rows and columns the selected cells will be split into.

9 Split Table splits the table into two, above the selected cell.

10 Autofit options can fit each cell to its contents (Autofit Contents), or stretch the table to fill the page (Autofit
Window). It can also be set to not automatically resize the table (Fixed Column Width), which may cause the table
to extend past the page edges if columns or rows are added.

Note: You can also change the size of a column or row by selecting and dragging its edges.

11 Alignment options let you choose how text will be aligned in the selected cells. Text can be aligned to any
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combination of top, bottom, left, right and center.

12 Use the Cell Margins button to set margins for the contents of cells, how much blank space will appear
between cells, or if cells should always autofit to contents.
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4444 OneClick for Admins — EasyEdit — TOneClick for Admins — EasyEdit — The Phe Paage Lage Layyoutout

ttabab

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

1 The Page Layout tab contains many options for structuring the pages in your document.

2 Select Margins to choose from a preset collection of margins, or select “Custom Margins...” from the menu that
appears to create your own.

3 Select Orientation to make pages appear in either portrait or landscape.

4 Select Size to choose from a variety of preset page sizes, including letter and A4. Select “More Paper Sizes...”
from the menu that appears to customize your own page size.
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5 Select Columns to choose how many text columns will appear on your page. A “More Columns...” option in the
menu that appears gives you fine control over the number, size and location of columns on the page.

6 The Breaks menu lets you add more page breaks to the document, in a variety of locations.

7 The Line Numbers menu lets you number every line of text, and provides some control over when those numbers
should restart. For example, numbers can restart on every page or by every section. Sections can be added
using the Breaks menu. You can also suppress line numbers for specific sections of the document, or use “Line
Numbering Options...” for even more granular control.

8 The Page Color menu lets you choose the background color of the pages in the document. You can select from
preset colors, or pick any color from a spectrum or via a hex value.
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Note: You can only select one color at a time. This color will appear on every page of the document.
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4545 OneClick for Admins — EasyEdit — TOneClick for Admins — EasyEdit — The Vhe View tiew tabab

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

1 Settings in the View tab change how the document appears while you are editing it. It does not affect how the
document will appear in the book.

2 The Simple view hides most of the page layout, focusing on the content only.

3 The Draft view is a quickly rendering view that makes it easier to edit the document quickly, but may hide page
elements like headers and footers.

4 The Print Layout view displays the page as it will appear in the book.

5 Showing the Horizontal Ruler displays the ruler at the top of the page. You can select on this ruler to add tab
stops to the document.

6 Showing the Vertical Ruler displays the ruler at the side of the page.

7 Zoom options make the document appear smaller or larger during editing.
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4646 OneClick for Admins — EasyEdit — Importing,OneClick for Admins — EasyEdit — Importing,

exporting and the File texporting and the File tabab

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

EasyEdit lets you import Word-compatible .docx files so you can continue to edit them in Diligent Boards. It also
lets you export .docx files for use in external editors.

1 The File tab contains file import and export options, as well as action undo and redo shortcuts.

2 To undo your last action, select Undo. You can use this multiple times to undo many of the previous actions that
were made since you started editing the file.

Note: You can also undo with the keyboard shortcut Ctrl+Z.

3 To redo actions that were undone, select Redo. If undo was used multiple times, redo can be used multiple
times as well.

Note: You can also redo with the keyboard shortcut Ctrl+Y.

4 To create an EasyEdit document based on an existing Microsoft Word-compatible .docx file, select Import
Document and select the .docx file to import. The file will be imported with formatting intact.

Note: Importing a document will overwrite any changes made to the existing document in EasyEdit.

Note: Importing a Document from Microsoft Word will maintain most text formatting.

5 To export the EasyEdit document to a .docx file that can be used in Microsoft Word, select Export Document
and choose a file name and location. The file will be exported with formatting intact.
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Note: QuickLinks in the document will be exported intact, but links to Diligent Boards documents will not
function until the document is uploaded into Diligent Boards, or re-imported as an EasyEdit document. See the
section in this guide on QuickLinks for more information.
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4747 OneClick for Admins — Selecting a book forOneClick for Admins — Selecting a book for

approapprovval from the home pal from the home paagege

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Selecting a book for approval opens it up in the Approve Book window, allowing you to view and approve or reject
its contents.

1 On your board’s home page, select the group the book belongs to from the Board and Committee Menu.

2 If the book is not visible in the Current Books list, right-click on or below the visible books and select Show
Hidden Books from the menu that appears.

3 The hidden books will now be visible to you, but not to anybody else. The hidden books will appear semi-
transparent to indicate that others still cannot see them.
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4 Right-click the book. Select Approve Book from the menu that appears. The book will open in the Approve Book
window.
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4848 OneClick for Admins — Selecting a book forOneClick for Admins — Selecting a book for

approapprovval from the admin home pal from the admin home paagege

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Selecting a book for approval opens it up in the Approve Book window, allowing you to view and approve or reject
its contents.

1 On the Admin home page, select the group the book belongs to from the Board and Committee Menu.

2 Select Edit Book.

3 Select Edit or Approve Book.
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4 Select a book from the menu that appears.

5 Select the Approve This Book’s Contents button. The book will open in the Approve Book window.
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4949 OneClick for Admins — TOneClick for Admins — The Approhe Approve Book windove Book windoww

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

The Approve Book window shows you the approval status of every tab of the book in a single location.

1 Tab text will appear in different colors depending on their approval status. Tabs that have been fully approved
for publication will appear in black text. Tabs that have been approved but still require further approval rounds will
appear in blue text. Tabs that contain rejected documents will appear in red text. Tabs with no documents appear
in gray.

2 Tabs that have newly uploaded content will be tagged with a red dot.

3 Select the Last Page Viewed button to go to the most recent page that you viewed previously, to continue on
from your last approval session.

4 Select View All Notes to bring up a list of all notes you have permission to read. This button will only appear on
books where notes have been created.

5 Select the Print Book button to print the unapproved book so you can review it while you’re away from a
computer.

6 Select Edit Book if you need to change the contents of the book. The Edit Book window will open.

7 Select any tab to open its documents in the Approval Window.
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5050 OneClick for Admins — ApproOneClick for Admins — Approving the bookving the book

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Approving a book’s content makes it simple to check that everything is correct before anything is delivered to
directors.

1 In the Edit Book window, select the View button next to a document slot. The document will open in the page
view window.

2 Type in a page number and select the Go arrow, or use the Left and Right Arrow buttons to page through the
document.
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3 Select Slideshow to view the document in a fullscreen format.

4 Use the Zoom options to change the on-screen size of the document.

5 Type a phrase into the Search field and select the Search button to find everywhere that term appears.

6 Use the above navigation options to check the document for correctness.

7 To reject the document, select the red Not Approved button.

8 When a document is rejected, you will be asked if you would like to leave a comment. Select Yes, or select No
to reject the document without a comment. Selecting Cancel will undo the rejection of the document.

Note: You can only leave comments on documents that are not approved.

9 To tentatively approve the document, select the blue Approve Not Final button.

Note: “Approve Not Final” is an optional setting and can be disabled if it is not needed. Contact your Customer
Success Manager for further information.

10 To approve the document for publication, select the black Approve Final button. If the book is published,
approved documents will be made available to all readers immediately. If the book is hidden, the document will
only be viewable when the book is published.
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11 To approve or reject multiple documents at once, select the drop-down arrow next to Not Approved, Approved
Not Final or Approved Final. From the menu that appears, select This Document to apply that approval status to
just the document that is currently open. Select The Entire Tab or The Entire Book if you would like to apply a
blanket approval status.

Note: If a tab has empty document placeholders, it will appear as “Approved Not Final” even if all the
documents in the tab are “Approved Final.” To change the tab’s status to “Approved Final,” remove the document
placeholders, or fill them and approve the new documents as final.

12 If you would like to approve the document but only for certain readers, select Hide Content. The Hide Content
window will appear.

13 Select the hiding options for the document and select OK. See the section on Hiding and Deleting Documents
for more information on the Hide Content window.

14 Select Create Voting Document if the document is to be voted on. For more information, see the instructions
about voting documents.
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Note: You can only leave comments on documents that are not approved.

15 To send a notification specifically associated with this document, select Document Notification once the
document has been approved. A dialog identical to the Book Notification dialog will appear, allowing you to send
a notification via email, Diligent Messenger, or push notification to directors. Document Notifications sent as push
notifications take directors right to the new or updated document.

Note: Push notifications are an optional feature that must be enabled for your site. See Sending notifications
about new books for more information about sending notifications.

16 To create a link to another book, a Resource Center document or a Web resource, highlight the text to link
and select Create QuickLink. For more information, see the instructions on Linking.
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5151 OneClick for Admins — Checking document stOneClick for Admins — Checking document staatustus

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

The Document Status window gives you a top-level view of every document in the book, including where and when
they were uploaded and if they have been approved. It also notes if any documents have yet to be uploaded.

1 In the Edit Book window, select Document Status. The Document Status window will appear.

2 Documents that have been uploaded will be noted with a check mark. Empty document placeholders will be
noted with a red question mark.

3 The Uploaded column contains the name of the administrator who uploaded the document, as well as the date
that the document was uploaded.

4 The Approved column contains whether or not the document has been approved, the name of the administrator
who approved the document, and the date that the document was approved, if applicable.

5 Select any icon in the History column to view the approval history of the associated document.

6 Select Print Page to print the Document Status information. You’ll be given the option to print with full approval
history for each document, as well as any comments that may have been left when documents were unapproved.
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7 Select Missing Documents to hide uploaded documents and only show empty document placeholders. This
button will only appear if empty document placeholders exist.

8 To see all the comments made by administrators regarding rejected documents, select View Comments. This
button will only appear if any rejected document comments exist.

9 The Admin Comments window will open. To see the entire comment, select anywhere on it.

10 Select Edit to change an administrator comment you made in the past.
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5252 OneClick for Admins — CreaOneClick for Admins — Creating QuickLinks inting QuickLinks in

upluplooaded documentsaded documents

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

More robust than hyperlinks, QuickLinks make it easy to turn any text into a link to another document or page.
These documents can be in the same book, a different book, or even in the Archive or Resource Center. QuickLinks
can also be made to external websites, including video conferencing links.

Note: Any links that you have previously created in the document you are uploading will be converted to
functioning QuickLinks in Diligent Boards.

1 In the Edit Book window, select View to add a QuickLink to an uploaded document.

2 Highlight the text you would like to make into a link.

3 Select Create QuickLink. The Create QuickLink window will open.
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4 If you are linking to another document in Diligent Boards, select the board or committee associated with that
document from the drop-down menu.

5 Select the section that contains the document to which you would like to link. The document can reside in a
current book, an archived book or the Resource Center. You can also link to a questionnaire.

6 In the list of resources that appears below the tab, expand the menus until you find the page to which you would
like to link. Select that page to highlight it.

7 If you are linking to an external website or conferencing platform, select the External Link tab. Type or paste the
site’s URL into the text field.

8 Select Create Link.
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5353 OneClick for Admins — CreaOneClick for Admins — Creating QuickLinks inting QuickLinks in

EasyEdit documentsEasyEdit documents

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

More robust than hyperlinks, QuickLinks make it easy to turn any text into a link to another document or page.
These documents can be in the same book, a different book, or even in the Archive or Resource Center. QuickLinks
can also be made to external web resources, like websites.

1 Select an EasyEdit button in the Edit Book window to add a QuickLink to that EasyEdit document.

2 Highlight the text you would like to make into a link.

3 Right-click the selected text and choose QuickLink... from the menu that appears. The Create QuickLink window
will open.
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Note: You can also access the Create QuickLink window by selecting the “QuickLink” button from the Insert tab,
which is located above the document.

4 If you are linking to another document in Diligent Boards, select the board or committee associated with that
document from the drop-down menu.

5 Select the section that contains the document to which you would like to link. The document can reside in a
current book, an archived book or the Resource Center. You can also link to a questionnaire.

6 In the list of resources that appears below the tab, expand the menus until you find the page to which you would
like to link. Select that page to highlight it.

7 If you are linking to an external website, select the External Link tab instead. Type or paste the site’s URL into
the text field.

8 Select Create Link.
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5454 OneClick for Admins — Editing and deletingOneClick for Admins — Editing and deleting

QuickLinks in uplQuickLinks in uplooaded documentsaded documents

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

1 Right-click the link you would like to edit or remove. To test it, select Follow QuickLink in the menu that appears.

2 To change the link, select Edit QuickLink. The Edit QuickLink will open. Editing a QuickLink is similar to creating
a QuickLink.

3 To remove the link, select Delete QuickLink.
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5555 OneClick for Admins — Editing and deletingOneClick for Admins — Editing and deleting

QuickLinks in EasyEdit documentsQuickLinks in EasyEdit documents

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

1 Right-click the link and choose Edit QuickLink... from the menu that appears. The Edit QuickLink window will
open. You can edit a QuickLink from here; editing a QuickLink is similar to creating a QuickLink.

2 To delete a QuickLink, select Delete Link in the Edit QuickLink window.
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5656 OneClick for Admins — CreaOneClick for Admins — Creating external QuickLinksting external QuickLinks

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

QuickLinks can be copied out of Diligent Boards for use in several types of external files: Microsoft Word,
Microsoft Excel, Microsoft Powerpoint, and PDF. These links will then link to the appropriate Boards content when
the file is imported into Diligent Boards.

1 In the Edit Book window, select View next to the document that contains the page to which you’d like to link.

2 Right-click on the page and select Copy Page Link Address from the menu. A link to the page will be copied to
the clipboard.
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3 This link can be treated as a hyperlink in an external document (Microsoft Word, Microsoft Excel, Microsoft
Powerpoint, PDF). In the application you're using, select the text you would like to turn into a link, right-click, and
select the option to add a Hyperlink.
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4 Paste the link into the Address field.

5 Select OK. The hyperlink will be created, and will function properly once the document is imported into Diligent
Boards. It will not function in an external application.
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5757 OneClick for Admins — Printing a bookOneClick for Admins — Printing a book

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Diligent Boards allows for straightforward printing of books for readers who prefer paper copies. Directors and
Administrators can print out books.

1 Select the board or committee that is associated with the book you want to print from the Board and Committee
Menu.

Note: This list will only display the boards and committees that you are authorized to access.

2 If the book is not visible in the Current Books list, right-click on or below the visible books and select Show
Hidden Books from the menu that appears. The hidden books will now be visible to you, but not to anyone else.

3 Right-click the book. Select Print Book from the menu that appears. The Print window will open.

|
199 of 312 | Diligent Corporation



4 Select the printer that you would like to use.

5 Under Page Range, select Print Book to print the entire book. To print a selection from the book, select Tab and
choose a single tab from the drop-down menu, or select Page Range and enter the first and last page numbers in
the page range fields.

6 Under Print Filter, select All Content to print every page in the range you selected. To only print pages that
have been approved for final publication, select Finalized Content Only. To print everything but final approved
content, select Not Finalized Content Only.

7 Enter how many copies of the book you would like to print.
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8 Uncheck Auto-Scale to Fit and change the scaling percentage to change the size of the document on the printed
page.

9 If the book is not printing correctly, select another Print Mode from the menu and try again. Different print
modes change the way the documents are rendered before they are sent to the printer.

10 Use the Additional Print Option checkboxes to add more features to the printed version of the book. From here
you can Include Table of Contents (choosing to include or exclude sub tabs), put a Blank Page Between Tabs,
Print Tab Numbers on Page Side and Print All Text Black regardless of the text’s color on screen.

11 You may also Include Notes and Highlights in the printed book.

12 Select the Page Setup tab.
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13 Change the Paper options if you would like to change the size of the paper the document will be printed on,
or the tray selection on your printer.

14 Change the Margins options to modify how much blank space will appear on the edges of each page of the
book.

15 Duplex options may also be available, if your printer supports them.

16 Custom Headers and Footers can be added to the document via a series of unique formatting codes. Consult
your Customer Success Manager for more information.

17 Select Preview to see how the book will look before committing to print it.

18 Select Export to create a PDF version of the book.
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19 Select Print to finalize the print job and send it to the printer.
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5858 OneClick for Admins — WOneClick for Admins — Waatermarking documentstermarking documents

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Watermarking adds information on who printed or exported a document, as well as when that copy of the
document was created. Watermarks can be displayed on the page view as well. This feature makes it easier to
hold users accountable for content extracted from Diligent Boards.

1 To enable watermarking on the page view and/or for printed and exported documents, Contact Your Customer
Success Manager. You can enable watermarking individually for:

2 By default, watermarks will appear behind the text of the document, and will display the user’s name. Below
their name, the date and time the document was printed or exported will appear.

Directors (this will apply to all Diligent Boards applications, including Diligent Boards for iPad and Windows)>
Administrators>
Boardpacks>
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Note: On the page view, the date and time that the book was last synced will appear.

3 You can also contact your Customer Success Manager to add customized text to the watermark. This text will
appear in place of the user’s name. The user’s name will be moved to the second line, alongside the date and time.
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5959 OneClick for Admins — CreaOneClick for Admins — Creating a vting a vooting documentting document

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Voting documents allow book readers to vote on business using a digital signature. Any document in a book may
be turned into a voting document. To view an in-depth webinar about voting in Diligent Boards, visit this link.

1 Once a document has been Uploaded or created in EasyEdit, it can be turned into a voting document. Select the
View button next to the document in the Edit Book window. The page view window will open.

2 If the document hasn’t been approved already, select Approve Final. Only approved documents can be made into
voting documents.

3 Select Create Voting Document. The Voting window will appear.
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4 Select Specify the Vote Administrator from the drop-down menu. The Vote Administrator will receive email
notifications on the outcome of the vote, as well as any questions asked about the vote.

5 If your list of voters and signature pages are frequently the same, select Copy settings from a previous vote.

6 Select Next. If you did not copy settings from a previous vote, go to Step 10.
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7 If you selected Copy settings from a previous vote, a list of your books will appear. Select the board or
committee that took the previous vote from the drop-down menu.

8 Select the tab that represents where the previous voting document is stored, Current Books or Archived Books.
If the document is in the Resource Center, select Company Info.

9 Expand the list of books, tabs and pages until you locate the voting document. Highlight it and select OK. The
settings from the document will be copied to the current voting document.
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10 Choose whether users will see For/Against or Yes/No options for the vote. Both selections include an "Abstain"
option.

11 Choose a vote type: Signature, Non-Signature, or Anonymous. Non-Signature and Anonymous votes do not
require an e-signature, and on Anonymous votes, individual responses are hidden from administrators and other
voters.

12 Two optional settings are also available: Allow Vote Comments (users can add an optional comment to explain
their vote) and Set Close Date (informs users of a deadline for a vote). Once you've made your choices, select
Next.
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13 Check the box by each person who will be voting. If a voter does not have a digital signature on file, an “Upload
Signature” link will appear next to their name.

Note: If you don’t see a voter on the list, that person doesn’t have voting rights enabled. Contact your Customer
Success Manager.

14 Under Voting Threshold, select the number of affirmative votes required for the vote to pass, and how many
of these votes should come from independent directors—directors that do not hold a salaried position at the
entity the board directs. Independent directors are specially designated in Diligent Boards. Contact your Customer
Success Manager for more information.

15 Select Next.

|
211 of 312 | Diligent Corporation



Note: If the vote requires a signature and you added a voter without a digital signature on file, an alert will
appear when you select "Next." Select “No” to stay on this screen, then select a user's "Upload Signature" link
to add a signature file. The signature file must be a JPG, TIF or PNG image that is exactly 210 pixels wide
and 45 pixels high. Contact your Customer Success Manager if you require assistance creating or uploading a
signature.

Note: You may proceed with voters without a signature, but they will need to add one or have one added before
they are able to cast an affirmative vote.

16 If the vote requires a signature, voter signature boxes will appear on the document. Use the Arrows to navigate
between pages in the voting document. You can put any signature on any page of the voting document.

Note: You must stay on the pages of the same voting document while you are building it.

17 Use the Arrows by the signatures to cycle through each one. You can also select the Search button between
the arrows to select the name from a menu.

18 Drag and drop the Signature into position. You may have to drag the Voting window out of the way to see the
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document. Drag the signature to the left or right edge of the page to move it to the last or next page, respectively.
Select Next in the Voting window when all the signatures are in the right place.

19 Right-click a signature and select Reset Signature to return it to the stack. You can also Reset All Signatures
on this Page, or Reset All Signatures on the document.

20 When the Send Notification checkbox is enabled, a notification dialog will launch once the vote is activated.
See the Sending notfications about new books for more information on notification functionality.

21 Select Activate to complete the voting document.
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Note: Once a voting document is activated, it cannot be changed, only deleted.

Did you know? A voting document is a great way to vote on approvals of minutes. Diligent Minutes can improve
the minute-taking process further, ensuring this critical meeting record is easy to create, easy to manage, and
fully secured from creation to approval. You can learn more about Diligent Minutes here.
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6060 OneClick for Admins — Checking vOneClick for Admins — Checking voote stte staatustus

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Administrators can check the results of any completed vote, or the current status of any vote in progress.

1 In the Edit Book window, select Approve This Book. The Approve Book window will open.

2 Select View Voting Items.

3 The Voting Items window will appear. Look in the Status column to see if a vote is in progress, or if it has
passed.

4 Select View Document to jump to the start of the voting document.
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5 Select Cast Your Vote to go right to the first page in the document where a vote will be cast (which may be either
the first page of the document, for votes that do not require a signature, or the first signature page, for votes that
do require a signature).

6 Select a vote's status (such as In Progress) to get detailed information.

7 The Voting Status window will open, listing vote information, including a vote summary, who has voted and how
they voted (for non-anonymous votes), and how many votes are required for passage.

8 Select Send Notification to send a reminder to users who have not yet voted. The notification dialog is identical
to other notification screens throughout the application, and the "To" field will be pre-populated with the users who
have not yet voted.
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Did you know? The most secure way to immediately notify directors about pending votes is via Diligent
Messenger, which will secure the communication using the same methodology as Diligent Boards. It can also
directly alerts directors on their iPhones. Learn more.
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6161 OneClick for Admins — Questionnaires — Adding aOneClick for Admins — Questionnaires — Adding a

new questionnairenew questionnaire

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Questionnaires provide an easy way to gather detailed feedback from any user of your Diligent Boards site. To
view an in-depth webinar about using questionnaires in Diligent Boards, go here.

Video — How to Create and Post a Questionnaire

Youtube

Step-By-Step Instructions

1 To add a questionnaire to your Diligent Boards site, select Manage Questionnaires from the Admin home page.
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2 Select Create New.
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3 Enter a name for the questionnaire.

4 To help organize the questionnaires, you may enter a Questionnaires Category and Questionnaires Description.
Only administrators will see this information.

5 Select the Groups tab to specify the groups or committees to which the questionnaire should be distributed.

6 Select the Users tab to specify specific individuals that should have questionnaire access.

7 Select Save. The Questionnaire Builder will open.
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6262 OneClick for Admins — Questionnaires — Adding anOneClick for Admins — Questionnaires — Adding an

Introduction pIntroduction paage tge to a questionnaireo a questionnaire

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Once you have created a new questionnaire, you are ready to begin adding and managing questionnaire content.
This page describes how to include an Introduction page to the questionnaire.

To learn how to organize questionnaire content by page, see Adding and managing pages. To learn how to add
questions to your questionnaire pages, see Adding and managing questions.

1 The Introduction page is a cover page where you can display your company logo and specific instructions about
the questionnaire. It is disabled by default.

2 If you wish to display an Introduction page, select the Edit button to open the Introduction Edit window.
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3 To make the Introduction page visible to directors, enable Include Introduction Page. This option must be
enabled in order for the Introduction page, and any content added to it, to appear with the questionnaire.

4 To include the company logo on the Introduction page, enable Display Site Logo.

5 To add content to appear on the Introduction page, enter it into the Introduction Text field.

6 To record your Introduction page changes and return to the Questionnaire Builder, select Save.
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6363 OneClick for Admins — Questionnaires — Adding andOneClick for Admins — Questionnaires — Adding and

manamanaging questionnaire pging questionnaire paagesges

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Use pages to organize the questionnaire in manageable sections and group questions by topic. The below steps
descibe how to add, name, order, and remove questionnaire pages.

1 To add a new page to the questionnaire, select Add A Page.

2 To change the name of a page, first, select the Edit icon for that page, then enter the new name for the page.
Page names are useful to keep content organized as you build the questionnaire, and are only visible to you and
other administrators.

3 To change the order of pages, select and hold a page icon, then drag it to a new position in the page list. A blue
line will appear under the dragged icon to show where the page will be placed. Release the page to leave it in this
new location.
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4 To remove a page from the questionnaire, select the Delete icon on that page. All questions on the deleted page
will be removed as well.

5 To view a page, select it from the list. From here, you can add and manage questions for that page.
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6464 OneClick for Admins — Questionnaires — Adding andOneClick for Admins — Questionnaires — Adding and

manamanaging questionsging questions

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

This page describes how to add different types of questions to questionnaire pages, and includes a brief overview
of each question type.

1 On any page, select Add a Question in the location in which you would like a question to be added.

2 From the menu that appears, select a question type.

Note: You may also drag and drop from the Question Types column on the right-hand side to the location where
you would like to add that type of question.

2a Text questions require a written answer.

2b List questions are multiple choice.

2c Number questions require the answer to be a number.

2d Date questions require the answer to be a date.

2e Email questions require a valid email address as an answer.

3 Select Message to place a text-only message, without answer options, after the selected question.
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4 Select the Delete button to delete a question.

5 Select the Edit button to make changes to an existing question.

6 Select and hold the Drag button to move the question elsewhere on the page. While holding the mouse button,
move the question to a new location and release the mouse button.

7 Select Add a Sub Question to create a question that appears as part of another question.
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6565 OneClick for Admins — Questionnaires — TOneClick for Admins — Questionnaires — Textext, D, Daate,te,

and Email question typesand Email question types

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

This page includes details about writing the following types of questions after you have added them to the
questionnaire:

Content for each of these types of questions is added through the same method, described below.

1 After adding a Text, Date, or Email question, a question editor dialog will appear. If you would like the question
to display a title, select the Title Edit icon and type it in.

2 To write the question, type it into the text editor. You may also copy and paste text into the text editor.

3 The Required checkbox is enabled by default. When enabled, the question must be answered in order to submit
the questionnaire. Deselect this checkbox to make the question optional.

4 To display the question text and response field side by side, enable Show question label and control on the
same line. If not selected, the response field will appear below the question.

5 The Numbered question checkbox is enabled by default. When enabled, the question will be numbered in
sequence with all other numbered questions.

6 To display a gray background behind the question title, enable Show background title bar. This option can be
used to delineate sections of related questions.

7 Select Save to add the question to the questionnaire.

Text questions, which include a plain text answer field for respondents>
Date questions, which require an answer in the form of a date>
Email questions, which require an email address as an answer>
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6666 OneClick for Admins — Questionnaires — TOneClick for Admins — Questionnaires — The Numberhe Number

question typequestion type

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

This page includes details about Number questions, which require the respondent to enter a number as an answer.

1 After adding a Number question, a question editor dialog will appear. If you would like the question to display a
title, select the Title Edit icon and type it in.

2 To write the question, type it into the text editor. You may also copy and paste text into the text editor.

3 To require a response within a specific number range, enable the Number Range checkbox.

3a Then, enter a minimum and maximum value to define the range.

4 The Required checkbox is enabled by default. When enabled, the question must be answered in order to submit
the questionnaire. Deselect this checkbox to make the question optional.
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5 To display the question text and response field side by side, enable Show question label and control on the
same line. If not selected, the response field will appear below the question.

6 The Numbered question checkbox is enabled by default. When enabled, the question will be numbered in
sequence with all other numbered questions.

7 To display a gray background behind the question title, enable Show background title bar. This option can be
used to delineate sections of related questions.

8 Select Save to add the question to the questionnaire.
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6767 OneClick for Admins — Questionnaires — TOneClick for Admins — Questionnaires — The Listhe List

question typequestion type

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

This page includes details about writing List questions, which provide a list of options from which the respondent
can choose.

1 After adding a List question, a question editor dialog will appear. If you would like the question to display a title,
select the Title Edit icon and type it in.

2 To write the question, type it into the text editor. You may also copy and paste text into the text editor.

3 To add a response option, type it into the field labeled Create an Option and Select ‘Enter.’ Continue adding
options in this manner, using the Enter key between options.
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4 To use response options from an existing List question, select Copy an Existing Question’s Options, then select
a question from the dropdown menu. That question's options will be copied to the current question.

5 To remove an option, select its Delete icon.

6 To modify the text of an option, select its Edit icon.

7 To move an option to a different location in the options list, select and hold its Move icon, and drop it in its new
location.
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8 To display response options as radio buttons in a horizontal line, enable Show as a rating table. Respondents
will only be able to choose one answer in this format. When this option is unchecked, shorter lists of options
display with checkboxes, and longer lists display as a dropdown menu.

9 To limit the respondent to choosing only one answer, enable Only one answer in the list can be selected.

10 To provide an "Other" option with a text field, enable Include an ‘Other’ option.

11 To add an additional text field for comments, enable Include comments box. Respondents can use this field to
add optional detail to their answers.

12 The Required checkbox is enabled by default. When enabled, the question must be answered in order to submit
the questionnaire. Deselect this checkbox to make the question optional.
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13 To display the question text and response options side by side, enable Show question label and control on the
same line. If not selected, the response options will appear below the question.

14 The Numbered question checkbox is enabled by default. When enabled, the question will be numbered in
sequence with all other numbered questions.

15 To display a gray background behind the question title, enable Show background title bar. This option can be
used to delineate sections of related questions.

16 Select Save to add the question to the questionnaire.
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6868 OneClick for Admins — Questionnaires — ContingentOneClick for Admins — Questionnaires — Contingent

questionsquestions

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

This page describes how to add contingent questions, which only appear to respondents who have provided a
specific answer to an earlier List question.

1 When adding a question of any type, select Contingent Question. This option will only appear if a list question
has already been created and placed earlier in the questionnaire.

2 From the dropdown menu that appears, select the List question that will determine whether this contingent
question will be hidden or displayed.

Note: Only List questions will appear in this dropdown menu.

3 Select the answer or answers to the selected List question that will cause this contingent question to appear. If
you select multiple answers, this contingent question will become visible if the respondent chooses any of them.

4 Fill out the remainder of the question window as you would for that question type.

5 Select Save.
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6 The contingent question will appear in the Questionnaire Builder with a link icon. It will only appear to a
respondent when they have selected a previous answer or answers as defined in Step 3.
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6969 OneClick for Admins — Questionnaires — FinalizingOneClick for Admins — Questionnaires — Finalizing

the questionnairethe questionnaire

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

This page describes how to edit the final page of your questionnaire, and preview the appearance of the
questionnaire to respondents.

1 In the Questionnaire Builder, select the Submission page.

2 To edit the final message in the questionnaire, select the Edit button. You may also use the default message
without editing it.

3 To test the questionnaire, select the Preview button. The questionnaire will be displayed as it would be to
directors.
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4 To end the preview session and return to the Questionnaire Builder, select Back.

5 To return to the Questionnaire Manager screen, from which you can publish the questionnaire, select Back from
the Questionnaire Builder screen.
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7070 OneClick for Admins — Questionnaires — ManaOneClick for Admins — Questionnaires — Managingging

and publishing questionnairesand publishing questionnaires

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

This page describes how publish the questionnaire, as well as how to edit questionnaire content and properties.
These tasks are all accomplished from the Questionnaire Manager screen.

1 In the Questionnaire Manager, select a questionnaire to access management options in the right-hand panel.

2 To open the Questionnaire Builder and update questionnaire content, select Edit.

3 To test the questionnaire, select Preview. The questionnaire will display as it would to respondents. Select
the "Back to Manager" button in the upper-left-hand corner of the Preview window to return to the Questionnaire
Manager.

4 To edit the questionnaire’s name, category and description, and to change who has access to the questionnaire,
select Properties. Update these properties as you did when you created the questionnaire.
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5 To create a new questionnaire with identical contents, select Duplicate.

6 To erase the questionnaire, select Delete. Any submissions will also be deleted.

7 To start the process of making the questionnaire visible to directors, select Publish. You will still be able to
cancel before actually publishing, in the next window that appears.

8 After selecting Publish, select a Close Date, Time and Time Zone for the questionnaire. This is the last minute
that responses will be accepted.

Note: Respondents will see the close date and time of the questionnaire in their local time zone.

9 Select Keep Submissions Anonymous to hide the identities of respondents. You will receive answers only. The
names of respondents will not be provided.

10 Select Next.
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11 You will be given one more opportunity to change the name, category and description of the questionnaire,
as well as who can access it. Select Next until the Questionnaire Summary appears. Select Publish to make the
questionnaire available to participants. The questionnaire will now appear in the Questionnaires section of the
participant’s home page.
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Note: You cannot make changes to a questionnaire after it has been published.
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7171 OneClick for Admins — Questionnaires — AdditionalOneClick for Admins — Questionnaires — Additional

questionnaire feaquestionnaire featurestures

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

For even more advanced features, Diligent offers Diligent D&O. This powerful package includes the ability to
create signed questionnaires, and to let administrators answer questionnaires on behalf of participants. This
functionality makes questionnaires a versatile tool for:

1 Administering D&O questionnaires directly from Diligent Boards.

2 Creating surveys where signed submissions are a legal or policy requirement.

3 Answering questions on behalf of your busiest members, so all they have to do is confirm and submit those
answers.

4 Implementing table questions: questions where the answer is entered as a spreadsheet of data. This question
type is ideal for asset reporting and biographical information.

5 Duplicating both questionnaire questions and answers, so questionnaires that don’t change much from year to
year can be quickly created and pre-answered without having to start from scratch.

Note: For more information about adding Diligent D&O to your Diligent Boards, contact your Customer Success
Manager.
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7272 OneClick for Admins — Questionnaires — GaOneClick for Admins — Questionnaires — Gatheringthering

questionnaire responsesquestionnaire responses

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

This page describes how to track respondent progress and export responses.

1 After publishing a questionnaire, a progress bar will appear in the Questionnaire Manager. This bar displays, as
a percentage, how many responses to the questionnaire have been received.

2 Select Submission Manager to gather the responses.
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3 Select the Master Questionnaire to reveal many of the same options available in the Questionnaire Manager.

4 In the Submission Manager window, select any participant to highlight them.

5 Select Preview to view the respondent’s answers.

6 Select Export Individual to print the respondent’s answers, or to save them to a spreadsheet or PDF.

7 Select Export All Participants to print all of the respondents’ answers, or to save them to a spreadsheet or
PDFs.

8 Select Admin Home to exit questionnaires and return to the Admin home page.
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7373 OneClick for Admins — Questionnaires — PrintingOneClick for Admins — Questionnaires — Printing

questionnairesquestionnaires

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Questionnaires can be printed, whether you need a blank copy with only questions, or a record that also contains
participant answers.

1 In the Questionnaire Manager, select a questionnaire.

2 To make a blank copy of the questionnaire that contains questions only, select Export.

3 Select Send to Printer. The Export Options window will appear.
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4 Select the printer you would like to print to, as well as any additional printing options if necessary.
Select Properties to reveal more printing options.

Note: The available printing options in the Export Options window and the Properties window will change
depending on the capabilities of your printer.

5 Select Print. A blank copy of the questionnaire will be sent to your printer.
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6 To print questionnaires that contain participant answers, select the Submission Manager. The Submission
Manager window will open.
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7 To print the answers of a single participant, select that participant to select them.

8 Select Export Individual, and then Send to Printer. The Export Options window will appear as it did for a blank
questionnaire. Select the printer, any options as necessary, and select Print when you’re done. The questionnaire
will be printed with that participant’s answers filled in.

9 To print the answers of every participant, select Export All Participants, and then Send to Printer.
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10 The Select Participants window will open with everyone selected. Select or deselect any participants, or use
the buttons above the list to Select All, Deselect All or select only those who have completed the questionnaire
to 100%.

11 Select Next. The Export Options window will appear as it did for a blank questionnaire. Select the printer,
any options as necessary, and select Print when you’re done. Multiple questionnaires will be printed, with each
participant’s answers filled in sequentially.
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7474 OneClick for Admins — Questionnaires — ExportingOneClick for Admins — Questionnaires — Exporting

questionnaires tquestionnaires to PDFo PDF

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Questionnaires can be exported to PDF, whether you need a blank copy with questions only, or a record that also
contains participant answers.

1 In the Questionnaire Manager, select a questionnaire.

2 To make a blank copy of the questionnaire that contains questions only, select Export.

3 Select Export as PDF Document. The Export Options window will appear.
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4 In the Document Name field, type the name of the PDF that will be created.

5 Select Change Location to choose the folder where the PDF should be saved.

6 Select Save PDF. The PDF will be created, and a link to it will appear.
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7 To export questionnaires that contain participant answers, select the Submission Manager to open it.
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8 To export the answers of a single participant, select the participant.

9 Select Export Individual, and then Export as PDF Document. The Export Options window will appear as it did
for a blank questionnaire. Name the PDF and select its location, and select Save PDF when you’re done. The
questionnaire will be saved with that participant’s answers filled in.

10 To export the answers of every participant, select Export All Participants, and then Export as PDF Document.
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11 The Select Participants window will open with everyone selected. Select or deselect any participants, or use
the buttons above the list to Select All, Deselect All or select only those who have completed the questionnaire
to 100%.

12 Select Next. The Export Options window will appear as it did for a blank questionnaire. Name the PDF and
select its location, and select Save PDF when you’re done. Multiple questionnaire PDFs will be exported, with each
one containing the answers of a different participant.
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7575 OneClick for Admins — Editing the Resource CenterOneClick for Admins — Editing the Resource Center

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

The Resource Center is where your board’s library of reference and governance materials is stored.

Video — Using the Resource Center

Youtube

Step-By-Step Instructions

1 On the Admin home page, select Edit Res. Center. The Edit Resources window will open.

Note: Additional information is available if you're trying to add new documents to an empty Resource Center.
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2 The main section of the Edit Resources window displays the folders of the Resource Center, as well as any
associated uploaded documents, document placeholders, EasyEdit documents and sub folders.

3 Select the Edit Alert button to modify the sign-in Alert.

4 Select the group the Resource Center belongs to from the Board and Committee Menu.

5 Select whether the folders and documents you are editing will appear in Column A or Column B. In Diligent
Boards OneClick, Resource Center items appear separated into these two columns. In other versions of Diligent
Boards, this selection will not change how Resource Center items are displayed.

Note: To change the names of the columns, contact your Customer Success Manager.

6 Select Refresh Items to see any changes that another admin may have made to the Resource Center since you
started editing it.

7 Select Document Status to open a window displaying more information about the book, including who approved
which documents and upload dates.

8 Select Expand All Items to reveal every document and placeholder.

9 Select Collapse All Items to hide all documents and show only folder names.

10 To expand or collapse a specific folder, select its Expand/Collapse button.

11 Select the Edit Another Book button to open the Edit Another Book side menu, allowing for quick access to
other sections of the board book. Select the button again to hide the menu.
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7676 OneClick for Admins — Adding a Resource CenterOneClick for Admins — Adding a Resource Center

folderfolder

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Folders allow you to organize and categorize the materials in the Resource Center.

Note: Additional information is available if you're trying to add new documents to an empty Resource Center.

1 There are multiple ways to add folders depending on where they should be located. In the Edit Resources
window, select Add Item At End to create a new folder that will appear after all previously created folders.

2 Select the Add SubItem button to add a new folder within an existing folder. This button is labeled with a right-
facing arrow. You can also add subfolders to other subfolders using this method.

3 Select the Insert Item button on a folder or subfolder that already exists to add a new folder directly before it.
This button is labeled with an upward-facing arrow.
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4 Using any method to create a new folder will open the Create or Edit Item window.

5 Enter a new Title for the folder.

6 Folders are numbered based on the order in which they appear in the Resource Center. Check Non-Numbered
Item to remove this numbering.

7 Select the Groups tab to change the user groups that have access to this folder.

8 Select the Categories tab to change the categories that are associated with the folder. Categories are additional
fields that readers can use to filter Resource Center items.

9 If you need to make a folder that is similar in structure or content to an existing folder or board book tab, select
Copy An Existing Item. The Copy Tab window will appear.

Note: If you made any changes in this window before copying the item, none of these changes will be applied
to the copy except title changes.

10 From this window, select the meeting or Resource Center location the tab or folder resides in, and then locate
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the tab or folder in the list that appears. Select it and select Copy. You will return to the Create or Edit Item window.

11 If you do not need to copy a tab or folder, you can continue Editing the Item manually or you can select OK and
edit it later.
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7777 OneClick for Admins — Editing, deleting andOneClick for Admins — Editing, deleting and

publishing a Resource Center folderpublishing a Resource Center folder

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Editing a folder allows you to create, manage and delete placeholder locations where documents can be created
or uploaded. You can also delete the folder entirely.

1 In the Edit Resources window select the Edit Item button. This button, which is labeled with a pencil icon, will
open the Edit Item window.

2 Select Append Document to create a slot into which a document can be Uploaded. Document slots are optional
and act as a reminder of where you will be placing a document that is not available yet.

3 Select Append EasyEdit Document to create a blank EasyEdit document. EasyEdit documents are Microsoft
Word-compatible documents that can be imported, edited and exported directly from within the Diligent Boards
Admin Client.
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4 You may type in a name for the document slot or EasyEdit document. This isn’t required, and will only be visible
to other administrators.

5 Select Insert Doc or Insert EasyEdit to insert a new document slot or blank EasyEdit document directly above
the chosen document location.

6 Select the Categories button to change the categories that are associated with the slots or documents.
Categories can be used as Resource Center filters.

7 Use the Up and Down Arrows to rearrange the slots and documents.

8 Select the Delete button associated with a placeholder slot to remove it, as well as any document it may contain.

9 Select Delete Item to remove the folder and all of its documents.

10 Under Directors View, select Hidden to prevent readers from seeing the folder and its contents. Select Online
Only to publish the folder. Select Available Offline to allow readers to download the folder so it can be read
without an Internet connection.

11 Select OK to save your changes to the Resource Center.
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7878 OneClick for Admins — Resource Center caOneClick for Admins — Resource Center categoriestegories

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Resource Center categories can be customized to give readers another way to filter reference and governance
materials.

1 In the Edit Resources window, select Edit Categories. The Create/Edit Categories window will appear.

2 Select Add Category.

3 Type the name of the new category into the text field.

4 Check Enabled to make the category active. Uncheck it to hide the category from administrators and readers.

5 If folders or documents have been categorized, that category’s Is Used box will be checked.

6 Select Delete to remove the category.

7 Select OK to save your changes.
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8 To add a folder or its contents to a category, select its Edit Item button. This button is labeled with a pen icon.
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9 Select a document’s Categories button.
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10 Use the checkboxes to add the document to one or more categories.

11 Select OK.

12 To change the entire folder’s categories, select the Categories tab.
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Note: If you have changed a document’s categories, you will not be able to change the categories of the folder
it’s in until you save. Select “OK” and return to the folder’s Edit Item window to continue.

Did you know? Directors don't need to look to your Resource Center materials alone to learn about events that
shape their industry. News Analytics, included in Diligent Boards, provides both industry news and interpretation.
Learn more.
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7979 OneClick for Admins — Re-ordering Resource CenterOneClick for Admins — Re-ordering Resource Center

folders and documentsfolders and documents

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

1 To move a folder to a different position, in the Edit Resource Center window, select and hold anywhere on a
folder.

Note: Selecting the “Collapse All Items” button will hide all information except for folder names, which may help
when re-ordering a significant number of folders.

2 While still holding down the mouse button, drag the folder until you see the blue Insert Item line. This indicates
the new location in which the folder will be placed.

When the Insert Item line is in the right place, release the mouse button. The folder will move to its new position.

3 To move a document to a new position in its folder, select and hold that document’s file name.
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4 Move the document to any position in the folder. A blue Insert Document line will appear if the document can
be moved to that location. Release the mouse button to move the document there.

Note: While documents can be arranged within a folder, they cannot be moved between folders. To move a
document to a new folder, delete it from its current location and add a new copy to the Resource Center.
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8080 OneClick for Admins — UplOneClick for Admins — Uplooading and approading and approvingving

Resource Center documentsResource Center documents

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Uploading a document to the Resource Center is similar to uploading documents to a board book. Approving a
document works similarly as well.

1 In the Edit Resources window, drag and drop documents onto any existing Resource Center folder. You can drag
documents above, below or between any documents that are already in the folder, or onto empty folders. If you
select and drag multiple documents at once, they will all be placed in that location. The following document types
are supported:

Note: Documents can be dragged from local storage (like the “My Documents” folder) and network drives. You
can also drag and drop email attachments from Microsoft Outlook.

2 If you previously created an empty document slot as a reminder, you can also drag and drop a single document
directly into the slot.

3 As an alternative to dragging and dropping, you can also select the Upload button next to an existing document
slot in the Edit Resources window.

Regardless of the method you choose to add documents to the book, the Upload window will open. Consult the
Uploading Additional Documents instructions for further assistance.

Note: “Mark As New,” “Public Comment” and “Private Comment” are not available options in the Resource

Microsoft Word documents (.doc, .docx)>
Microsoft Excel workbooks (.xls, .xlsx)>
Microsoft PowerPoint presentations (.ppt, .pptx)>
Adobe PDF documents (.pdf)>
Rich Text Format documents (.rtf)>
Plain text documents (.txt, .asc)>
Common image formats (.jpg, .png)>
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Center. Resource Center changes cannot be added to Update History.

4 To approve a document, select the View button in the Edit Resources window. Consult the Approving Book
Content instructions for further assistance.

Note: “Approve Not Final” is not an available option in the Resource Center.

Did you know? You can store information about director conflicts, controlling interests and more in Diligent
Entities, and automatically pull that information directly into the Resource Center. Diligent Boards will always
sync with Diligent Entities, keeping that information up to date. Learn more about Diligent Entities here.
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8181 OneClick for Admins — User manaOneClick for Admins — User managementgement

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

The Diligent Boards Admin Client provides a robust set of user management tools for changing passwords,
managing roles, and more.

Note: Access to many of the settings below can be enabled or disabled based on your internal policies, or the set
responsibilities of each administrator user. Contact your Customer Success Manager for more information.

1 On the Admin home page, select the group the user belongs to from the Board and Committee Menu.

2 Select Edit Contacts.

3 To manage the board and committee membership settings of each user, select Manage All Roles.

4 Selecting a user from the Edit Contact section will let you edit their contact information, upload a signature to
their account, or update their security question answers.

5 Selecting a user from the Edit Password section will allow you to help with password resets.

6 The Users and Security menu provides a variety of tools for the following tasks:

Approving newly created user accounts>
Exporting a list or grid of all users>
Managing the board and committee memberships of each user>
Manage authorized devices, if Device Authorization is enabled for your site>
Grant site access to Diligent Support>
Manage timeout settings, so they can be relaxed on meeting days>
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Did you know? Diligent Boards users can sign into other Diligent applications, like the secure, leadership-only
texting tool Diligent Messenger, using their Diligent Boards user name and password. Learn more here.
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8282 OneClick for Admins — ApproOneClick for Admins — Approving new usersving new users

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

To help ensure a highly secure board book environment, administrators must approve all new users before they
can access Diligent Boards.

Note: When your Customer Success Manager creates a new user account, you will receive an email requesting
that the user be approved.

Note: If there are any new users awaiting approval, you will be notified every time you sign in to the Diligent
Boards Admin Client. If you select “Approve User Accounts” in this window, skip to step 4.

1 On the Admin home page, select the group the user belongs to from the Board and Committee Menu.

2 Select Edit Contacts.

3 From the Users and Security menu, select Approve User Accounts.
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4 If you don’t see newly created users, select Refresh to see if they appear.

5 Using the checkboxes, select all of the users you would like to approve.

Note: If you see any users that should not be approved, contact your Customer Success Manager.

6 You can also Select All or Deselect All users at once.

7 When you’ve selected the users to approve, select Approve.

Note: You can also select “Approve & Set Password” if you are only approving one user (who is sitting on a
single board) and would like to change their password immediately.

8 In the window that appears, select Approve. The new users will now be able to access Diligent Boards. You will
receive an email confirming that the users are now approved.
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Note: If the person who will be approving new users shouldn’t have any access to board materials, contact your
Customer Success Manager and ask about setting up a new contact admin.

Did you know? Manually approving all new users is one way Diligent helps you ensure security best practices at
your organization. Learn more about other ways Diligent can help secure your data.
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8383 OneClick for Admins — ManaOneClick for Admins — Managing user rolesging user roles

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

As an administrator, you can control to which boards and committees most users belong.

1 On the Admin home page, select the group the user belongs to from the Board and Committee Menu.

2 Select Edit Contacts.

3 Select Manage All Roles.
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4 Select the board or committee you will be changing.

5 To add a user to this board or committee, select the Empty Gray icon by their name. It will turn into a green
Check icon.

6 To remove a user from this board or committee, select the green Check icon by their name. It will turn into an
empty gray icon.

7 If a user has a gray Lock icon next to their name, you cannot manage that user’s permissions. Contact your
Customer Success Manager for assistance.

8 Select Save.
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Note: If a user only has access to boards or committees that the admin does not control, the admin will not be
able to manage that user. Admins also cannot create new users that have access to books, and cannot delete
current users entirely. Contact your Customer Success Manager for assistance with any of these tasks.

Did you know? Adding or removing users from groups in Diligent Boards will change their group memberships
in Diligent Messenger as well, allowing you to manage access to secure board materials and secure board
communications with a single action. Learn more about Diligent Messenger here.
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8484 OneClick for Admins — Exporting a list of usersOneClick for Admins — Exporting a list of users

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Exporting a user grid creates a spreadsheet that lists the users on your site, as well as any group, committee and
permission information associated with those users.

1 On the Admin home page, select Edit Contacts.

2 From the Users and Security menu, select Export User Grid.

3 Choose a name for your spreadsheet, as well as where you would like to save it. Select Save.

|
291 of 312 | Diligent Corporation



The spreadsheet will contain the following information:

Note: Account approval status will only appear in the spreadsheet if you have permission to approve accounts.

This spreadsheet can be viewed and edited in Microsoft Excel.

Did you know? Exported user information is often proprietary and confidential. Consider storing these lists with
a secure storage solution like Diligent Secure File Sharing. Learn more.

The user’s full name, first name and last name>
The username of the account>
The user’s role or roles (administrator, director, etc.)>
The user's email address on file>
The meeting groups the user has access to, and their roles within each group>
If the user has offline access via Diligent Boards for iPad/Windows and/or Diligent Boards OneClick>
If the account has been approved for use by an administrator>
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8585 OneClick for Admins — Granting temporary siteOneClick for Admins — Granting temporary site

aaccessccess

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

To help ensure a highly secure board book environment, administrators must approve temporary access for
Diligent staff before they can access a site for support or account implementation.

Note: Temporary access can also be granted to new users that have not yet been approved for standard access.

1 When Diligent requests access to your site, you will receive an email containing all of the details. On the Admin
home page, select Edit Contacts.

2 From the Users and Security menu, select Manage Site Access.
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3 A list of pending and active temporary site access requests will appear. Selecting any one of these will reveal
more information about the request, including:

Note: Diligent can request access for multiple users in one request. Further request details, including exactly
what permissions will be granted to users, are available in the email you received when the request was created.

4 To approve this access request, select Allow Site Access. As soon as you do, the listed users will have access
to your site until the specified end date.

If the request is for Support or Account Implementation purposes>
The case number associated with the request>
The reason for the request, as provided by Diligent staff>
The committees and groups that access will be provided for>
The date and time when access will end>
The names of the users who will be granted access>
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5 Select Deny Site Access to deny the request.

6 You can also revoke active requests at any time by selecting one and selecting Revoke Site Access.

Note: Temporary users will not appear on user lists that you export.

|
295 of 312 | Diligent Corporation



8686 OneClick for Admins — TOneClick for Admins — Timeout manaimeout managementgement

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Administrators can enable more relaxed, temporary timeout settings for events like board meetings, so that board
members are not interrupted to re-enter their password.

1 On the Admin home page, select Edit Contacts.

2 From the Users and Security menu, select Manage Timeouts.

Note: If "Manage Timeouts" does not appear in this menu, it may not be enabled for your site or your account.

|
296 of 312 | Diligent Corporation



Contact your Customer Success Manager for more information.

3 The Manage Timeouts menu will appear. Select the Enable Extended Meeting Timeout checkbox to activate the
date range selection fields.

4 To open or close a view of your site's extended timeout settings, select Details.

Note: Extended timeout duration settings cannot be changed from the Admin Client. To update your site's
extended timeout settings, contact your Customer Success Manager.

5 With the Enable Extended Meeting Timeout box checked, select the From field to select or enter a start date for
extended timeouts.

6 Next, select the To field to select or enter the end date for extended timeouts.

Note: Extended timeouts begin at 12:00 AM on the selected "From" date, and end at 11:59 PM on the selected
"To" date. Dates and times are determined by your site's default time zone setting. Contact your Customer
Success Manager for more information.
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7 Select OK to confirm your extended timeout settings and apply extended timeouts.

Note: To disable extended timeouts and revert to your site's default timeout settings, uncheck the "Enable
Extended Meeting Timeout" checkbox. Extended timeouts will not be applied if this box is unchecked,
regardless of the date range that appears.
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8787 OneClick for Admins — Editing contOneClick for Admins — Editing contaact informact informationtion

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

The Contacts List contains information about board members, as well as Company Contacts that may not be on
the board but are still affiliated with the organization.

Video — How to Create and Edit Contacts + Add Signatures and Photos

Youtube

Step-By-Step Instructions

1 On the Admin home page, select the group the Contact List belongs to from the Board and Committee Menu.

2 On the Admin home page, select Edit Contacts.

3 To create a new Company Contact, select Create Contact. Company Contacts do not have access to board
materials.

4 To edit an existing Company Contact, select them from the Edit Contact menu on the Company Contacts page.

5 To edit a board member’s personal information, select them from the Edit Contact menu on the Main Board
Contacts page.
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6 Whether you are creating or editing a contact, the Contact Details window will appear. On the Contact Details
tab, fill out the person’s contact information. Only the First Name and Last Name fields are mandatory.

Note: Some contact information, including first name and last name, may not be editable. Contact your
Customer Success Manager to change this grayed out information.

7 You may delete certain Company Contacts by selecting the Delete button. This button will only appear if the
contact can be deleted.
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8 To add an optional photo of the contact, select the Photo tab.

9 Select Select Image. Browse your computer for the photo you wish to use. This photo must be 120 pixels wide
and 160 pixels high, and must be in JPG, GIF, BMP, PNG or TIF format. Contact your Customer Success Manager
for assistance in formatting Contact List photos.

10 To delete a photo, select Clear Image.

11 Select Save.
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8888 OneClick for Admins — Editing boOneClick for Admins — Editing board memberard member

signasignaturestures

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

Board members must have a digital signature associated with their account in order to participate in voting on
documents.

1 On the Admin home page, select the group the board member belongs to from the Board and Committee Menu.

2 Select Edit Contacts.

3 To upload or edit a board member’s digital signature, select them from the Edit Contact menu on the Main
Contacts page.

4 The Contact Details window will appear. Select the Signature tab.
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5 Choose Select Image. Browse your computer for the signature image you wish to use. This photo must be 210
pixels wide and 45 pixels high, and must be in JPG, GIF, BMP, PNG or TIF format. Contact your Customer Success
Manager for assistance in formatting the signature file.

6 To delete a signature, select Clear Image.

7 Select Save.

Note: Board members can also create their own signatures using handwriting tools built into Diligent Boards
for iPad and Diligent Boards for Windows.
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8989 OneClick for Admins — Editing boOneClick for Admins — Editing board memberard member

ppasswasswords and security questionsords and security questions

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

1 On the Admin home page, select the group the board member belongs to from the Board and Committee Menu.

2 Select Edit Contacts.

3 To edit a board member’s personal security information, select them from the Edit Contact menu on the Main
Board Contacts page.

4 Select the Security Questions tab in the window that appears. Select the security questions the board member
would like to answer, and type the answers into the associated fields.

5 To change the board member’s password, select Change Password.
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Note: The password can also be changed by selecting “Edit Contacts” on the Admin home page and selecting
the board member’s name from the “Edit Password” menu.

Note: If a user is on multiple boards, you will not be able to change their password. Contact your Customer
Success Manager for assistance administering this user.

6 The Change Password window will appear. Type in your own password to confirm your identity as an
administrator.

7 Type in a new password for the board member. This password must meet the security requirements that were
chosen when your site was initially configured.

|
306 of 312 | Diligent Corporation



Note: If your site didn’t customize its password policy, it may be using the Diligent Boards default settings.
Under these settings, passwords must be at least eight characters long, must not include the username, and
must not be one of the last 10 passwords used previously. It must also include three of the following: an upper-
case letter, a lower-case letter, a number and special characters (!@#$...).

8 Type in the new password a second time.

9 Check User must change password at next logon if you are creating a temporary password.

10 Select OK.

Did you know? Changing a user's Diligent Boards password will also change their password in Diligent
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Messenger, the secure communications tool that gives you full control over message discoverability and who
directors can communicate with. Learn more.
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9090 OneClick for Admins — Editing the calendOneClick for Admins — Editing the calendarar

As we continue to enhance our authentication options, we encourage the use of our web experience which
will feature the most up to date product innovations and best practice workflows.

The calendar keeps track of all of your board’s meetings and events.

1 On the Admin home page, select the group the calendar belongs to from the Board and Committee Menu.

2 Select Edit Calendar.

3 Select Sync To Outlook to make all events up-to-date in your Outlook calendar.

4 Select Print Calendar to make paper copies of the event list.

5 Select Day, Week or Month View to change the calendar view.

6 To create a new event or meeting, select New Item.

7 To edit an existing event or meeting, double-click its calendar entry.
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Note: You can also change the date of an event by dragging and dropping it to a new day on the mini-calendar, to
the left of the main calendar view.

8 Creating or editing entries opens the Calendar Item window. Select whether the item is a Meeting with a start
and end time, or an Event that lasts all day.

9 Enter the name, location, dates, times and time zone of the item, if applicable.

10 Select Admin Only if the item is one that only administrators need to see.

11 Select a color to change how the entry is highlighted on the calendar.

12 Paste video conferencing details, including URLs to video conferences run by a third party, into the Meeting
Details section. Any video conferencing URLs you add to this section will appear as links to your directors,
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allowing them easy access to the conference.

Note: You can add QuickLinks to a meeting description. If Current or Archived Books are linked, they will appear
in the Associated Books section of the calendar entry in the Diligent Boards for Windows. From there, they can
be viewed and managed.

13 Select the Groups tab to change which groups can view the calendar entry.

14 To remove the calendar entry you are editing, select Delete.

15 Select OK to save the entry to the calendar.

16 To make a copy of a calendar item, including all of its properties, right-click the item on the calendar, then
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select Copy. You can edit properties in the window that opens by following the directions above.
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